
Jeffrey A. Gerald, Billy E. Johnson, and Mark S. Dortch

August 2012

Approved for public release; distribution is unlimited.

Jeffrey A. Gerald, Billy E. Johnson, and Mark S. Dortch

Environmental Laboratory
U.S. Army Engineer Research and Development Center
3909 Halls Ferry Road
Vicksburg, MS 39180-6199

Final report
Approved for public release; distribution is unlimited.

Prepared for U.S. Army Corps of Engineers
Washington, DC  20314-1000
Abstract

This report was developed to provide a user guide and tutorial for applying the Training Range Environmental Evaluation and Characterization System (TREECS™). The purpose of TREECS™ is to provide the Army with varying levels of capability to forecast the fate of and environmental risk from munitions constituents (MC) — such as high explosives (HE) — present in and transported from firing/training ranges to surface water and groundwater. The overall objective is to provide environmental specialists with tools to assess the potential for migration of MC into surface water and groundwater systems and to assess range management strategies to protect human and environmental health. Tier 1 consists of screening-level methods that assume highly conservative, steady-state MC loading and fate. Tier 2 provides time-varying analyses. This report provides information to assist the user in learning how to apply TREECS™ for Tier 1 and 2.

DISCLAIMER: The contents of this report are not to be used for advertising, publication, or promotional purposes. Citation of trade names does not constitute an official endorsement or approval of the use of such commercial products. All product names and trademarks cited are the property of their respective owners. The findings of this report are not to be construed as an official Department of the Army position unless so designated by other authorized documents. DESTROY THIS REPORT WHEN NO LONGER NEEDED. DO NOT RETURN IT TO THE ORIGINATOR.
Contents

Abstract ................................................................................................................................................... ii

Figures and Tables ................................................................................................................................. vi

Preface ................................................................................................................................................. xiii

Unit Conversion Factors ...................................................................................................................... xiv

1 Introduction ..................................................................................................................................... 1
   Background .................................................................................................................................. 1

2 Getting Started ............................................................................................................................... 3
   User and Computer Requirements .......................................................................................... 3
   Acquiring and Installing Software ............................................................................................ 3
   Launching TREECS ................................................................................................................... 4
   File Hierarchy ............................................................................................................................ 4

3 Main Screen Features .................................................................................................................... 6
   Menu Bar .................................................................................................................................. 6
   File .......................................................................................................................................... 6
   References ............................................................................................................................... 7
   Reports .................................................................................................................................... 9
   Tools .................................................................................................................................... 10
   Web sites ................................................................................................................................. 14
   Options .................................................................................................................................. 16
   Help ..................................................................................................................................... 17
   Screen Selection Tabs ............................................................................................................ 18
   Installation/AOI Description .................................................................................................... 18
   Tier Analysis Selection ............................................................................................................ 20
   Site Conditions .......................................................................................................................... 20
   DoD Target Health Benchmarks .............................................................................................. 27
   Inputs .................................................................................................................................... 29
   Execute ................................................................................................................................... 30
   Uncertainty ............................................................................................................................... 31
   View Results ............................................................................................................................. 32

4 Model Inputs ................................................................................................................................... 34
   Tier 1 Models .......................................................................................................................... 34
   Soil Model ............................................................................................................................. 34
   Aquifer Model ....................................................................................................................... 38
   Surface Water Model ............................................................................................................ 39
   Tier 2 Models .......................................................................................................................... 42
   Soil Model ............................................................................................................................. 42
5 Using Viewers ......................................................................................................................... 70

Tier I Tables .................................................................................................................................. 70

Tier 1 Soil Mass Fluxes Table View .............................................................................................. 70

Soil .................................................................................................................................................. 70

Concentration Graphical View ...................................................................................................... 70

Concentration Probability of Exceedance .................................................................................. 73

Mass Flux Graphical View ........................................................................................................... 75

Mass Flux Probability of Exceedance ......................................................................................... 76

TREESCS Tier 2 Soil OUT Text Viewer ....................................................................................... 77

Vadose Zone Model ...................................................................................................................... 79

Mass Flux Graphical View ........................................................................................................... 79

Mass Flux Probability of Exceedance ......................................................................................... 79

Surface Water and Sediment ........................................................................................................ 80

Sediment Concentration Graphical View ..................................................................................... 80

Sediment Concentration Probability of Exceedance .................................................................. 82

Surface Water Concentration Graphical View ............................................................................. 82

Surface Water Concentration Probability of Exceedance ......................................................... 83

Surface Water Mass Flux Graphical View ................................................................................... 83

Surface Water Mass Flux Probability of Exceedance .................................................................. 84

RECOVERY Viewer ..................................................................................................................... 85

Contaminant Model for Streams (CMS) Viewer ......................................................................... 88

Groundwater .................................................................................................................................. 90

Concentration Graphical View ..................................................................................................... 91

Concentration Probability of Exceedance .................................................................................. 92

Mass Flux Graphical View ........................................................................................................... 92

Mass Flux Probability of Exceedance ......................................................................................... 93

Sensitivity/Uncertainty .................................................................................................................. 94

Cumulative Distribution Function Viewer .................................................................................. 94

Histogram Viewer .......................................................................................................................... 95

Partial R Viewer .............................................................................................................................. 96

Cumulative Probability ................................................................................................................. 98

Probability of Exceedance ............................................................................................................ 98

Sample Variable vs. Time with Confidence Bands ...................................................................... 100

6 Conducting Sensitivity and Uncertainty .................................................................................... 102

Specify Uncertain Parameters .................................................................................................... 102

Alias Input Variables .................................................................................................................... 103

Alias Output Watches .................................................................................................................. 104

Distributions/Correlations .......................................................................................................... 105

Run S/U model ............................................................................................................................. 109

References ..................................................................................................................................... 111
Appendix A: Using GIS ...................................................................................................................... 112
Appendix B: Using the HGCT ........................................................................................................... 145
Appendix C: Using Database Editors .............................................................................................. 159

Report Documentation Page
Figures and Table

Figures

Figure 1. Main screen of the TREECS UI................................................................. 6
Figure 2. The View dialog box of the References feature........................................ 8
Figure 3. The Print dialog box of the References feature........................................... 9
Figure 4. The Input Summary Report Options dialog box ......................................... 10
Figure 5. An example screen of the Input Summary Report....................................... 11
Figure 6. The Add/Edit user-specified Tools dialog box......................................... 14
Figure 7. The Add/Edit user Web sites dialog box................................................ 15
Figure 8. The Model Selection Dialog box............................................................ 16
Figure 9. Dialog box for setting the default TREECS working directory................. 17
Figure 10. The typical About TREECS dialog box.............................................. 17
Figure 11. Installation/AOI Description screen..................................................... 18
Figure 12. The Tier Analysis Selection tab of TREECS........................................... 20
Figure 13. Constituent Selection screen of the Site Conditions tab of TREECS..... 21
Figure 14. Constituent information dialog box where parameter values can be changed.... 24
Figure 15. Site Conditions/Operational Inputs for a Tier 1 analysis in TREECS........ 24
Figure 16. Site Conditions/Operational Inputs for a Tier 2 analysis in TREECS........ 25
Figure 17. An example of the detailed munitions information dialog box................. 26
Figure 18. The Inputs tab of TREECS................................................................... 30
Figure 19. An example of the Detailed Info dialog box for a given health benchmark. 29
Figure 20. The Execute tab of TREECS................................................................. 31
Figure 21. The Uncertainty tab of TREECS............................................................. 32
Figure 22. The View Results tab of TREECS........................................................ 33
Figure 23. Tier 1 soil model UI for POC application............................................. 35
Figure 24. Initial screen of the partition coefficient estimator tool of the Tier 1 soil model UI................................................................. 36
Figure 25. Soil texture/class screen of the partition coefficient estimator tool of the Tier 1 soil model UI................................................................. 36
Figure 26. $K_i$’s tab of the partition coefficient estimator UI in the Tier 1 soil model UI................................................................. 37
Figure 27. Characteristics screen of Tier 1 aquifer model UI for POC application........ 38
Figure 28. Well Information screen of Concentration Locations Tab of Tier 1 soil model UI for POC application................................................................. 39
Figure 29. Operational Inputs screen of Concentration Locations Tab of Tier 1 soil model UI for POC application................................................................. 39
Figure 30. Morphology and Hydrology screen of Tier 1 surface water model UI for POC application................................................................. 40
Figure 31. System Properties screen of Tier 1 surface water model UI for POC application................................................................. 40
Figure 33. Constituent/Site-specific Properties screen of Tier 1 surface water model UI for POC application. ................................................................. 41
Figure 34. Site Characteristics screen of the Tier 2 soil model UI. ...................................................................................................................... 43
Figure 35. Soil Properties screen of the Tier 2 soil model UI. .......................................................................................................................... 43
Figure 36. Hydrology screen of the Tier 2 soil model UI. ............................................................................................................................ 44
Figure 37. Fate/Transport Parameters screen of the Tier 2 soil model UI (part 1). .................................................................................. 44
Figure 38. Fate/Transport Parameters screen of the Tier 2 soil model UI (part 2). .................................................................................. 45
Figure 39. Chemical-Specific Parameters screen of the Tier 2 soil model UI. .......................................................................................... 45
Figure 40. Model Options screen of the Tier 2 soil model UI. ....................................................................................................................... 46
Figure 41. Kd Estimator tool UI within the Tier 2 soil model UI. ..................................................................................................................... 47
Figure 42. Composition screen for the MEPAS vadose model UI. .................................................................................................................. 49
Figure 43. Characteristics screen for the MEPAS vadose model UI. .......................................................................................................... 49
Figure 44. Constituent Properties screen for the MEPAS vadose model UI. .............................................................................................. 50
Figure 45. Soil class screen of the MEPAS vadose and aquifer model UI. ................................................................................................. 51
Figure 46. Composition screen of the MEPAS aquifer model UI. .................................................................................................................. 52
Figure 47. Characteristics screen of the MEPAS aquifer model UI. .......................................................................................................... 52
Figure 48. Concentration Locations screen of the MEPAS aquifer model UI. .......................................................................................... 53
Figure 49. Flux Locations screen of the MEPAS aquifer model UI. ............................................................................................................ 53
Figure 50. Constituent Properties screen of the MEPAS aquifer model UI. .............................................................................................. 54
Figure 51. UI for setting groundwater discharge to surface water. .......................................................................................................... 55
Figure 52. Morphology and Hydrology screen of the RECOVERY model UI. .......................................................................................... 57
Figure 53. The mixed sediment layer portion of the Morphology and Hydrology screen of the RECOVERY model UI. ................................................................. 57
Figure 54. The deep sediment layers portion of the Morphology and Hydrology screen of the RECOVERY model UI. ................................................................. 58
Figure 55. System Properties screen of the RECOVERY model UI. ............................................................................................................ 58
Figure 56. Constituent Properties screen of the RECOVERY model UI. ................................................................................................. 59
Figure 57. Calculated Data screen of the RECOVERY model UI. ................................................................................................................. 60
Figure 58. Model Parameters screen of the RECOVERY model UI. ............................................................................................................. 60
Figure 59. Model Parameters screen of the CMS UI. ................................................................................................................................. 63
Figure 61. Constituent Properties screen of the CMS UI. ............................................................................................................................ 65
Figure 62. Sedimentation Parameters screen of the CMS UI. ....................................................................................................................... 66
Figure 63. Loading Data screen of the CMS UI. ................................................................................................................................. 67
Figure 64. Default Numerical Settings screen of the Options button on the menu of the CMS UI. ............................................................................. 68
Figure 65. An example of the Tier 1 soil mass fluxes table viewer. .............................................................................................................. 71
Figure 66. An example of the Soil concentration graphical viewer. ........................................................................................................... 72
Figure 67. An example of the viewer browse for benchmark file dialog box. .......................................................................................... 72
Figure 68. An example of the soil graphical viewer showing two charts. ................................................................................................. 73
Figure 69. An example of MS Excel plot created for the soil graphical viewer. ....................................................................................... 74
Figure 70. An example of the Soil concentration probability of exceedance viewer. .................................................................................. 75
Figure 71. An example of the Soil concentration probability of exceedance viewer with K-S intervals.................................................................................................................................................... 76
Figure 72. An example of the mass flux graphical viewer for soil...................................................................................................................................................................................................................................................... 77
Figure 73. An example of the chart plotted when using the mass flux graphical viewer for soil ........................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................
Figure 103. Example of the initial dialog box displayed when the Specify Uncertain Parameters button has been clicked. ................................................................. 102
Figure 104. Example of the S/U module main dialog box for specifying uncertain parameters. ........................................................................................................... 103
Figure 105. Example of the S/U main form showing the Alias Output Watches node. .......... 105
Figure 106. Example of how times can be specified for aliased output watches in the S/U main form. .............................................................................................................. 106
Figure 107. Example of the Distributions/Correlations node emphasizing the Distribution tab. .................................................................................................................. 106
Figure 108. Example of the Distributions/Correlations node emphasizing the Correlations tab. .................................................................................................................. 107
Figure 109. Example of the Distributions/Correlations node emphasizing the Equation tab. 107
Figure A1. The Installation/AOI Description tab of TREECS. ......................................................... 112
Figure A2. The three main GIS areas of TREECS. ................................................................. 113
Figure A3. An example of the layer right-click pop-up menu for a grid layer in the GIS legend. 114
Figure A4. An example of the “Grid Info” dialog box for a grid layer. ........................................... 114
Figure A5. An example of the “Shapefile Info” dialog box for a polygon shapefile layer. ............. 115
Figure A6. An example of the “Properties” dialog box for a grid layer. ........................................ 116
Figure A7. An example of the “Grid Color Scheme” editor for a grid layer. ................................. 117
Figure A8. An example of the grid color Scheme editor’s prompt for a new grid filename. .......... 118
Figure A9. An example of the grid color scheme editor’s prompt for a grid file short name. ......... 118
Figure A10. An example of TREECS GIS workspace with the revised grid color scheme added. 118
Figure A11. An example of the “Properties” dialog box for a polygon shapefile layer. ................. 119
Figure A12. An example of the Properties dialog box for a line shapefile layer. .............................. 120
Figure A13. TREECS GIS Functions/Tools. .................................................................................. 120
Figure A14. An example of the “Resample Grid” tool’s main form. .............................................. 122
Figure A15. An example of the “AOI by Rectangle” tool’s main dialog box. ................................. 124
Figure A16. An example of the inquiry as to whether to use the AOI created or not. ..................... 124
Figure A17. An example of the zoomed workspace after adding an AOI. ....................................... 125
Figure A18. The message displayed when selecting the “AOI by Polygon” tool. ............................ 126
Figure A19. The “Measure” tool’s dialog box. ................................................................................. 126
Figure A20. An example of a workspace showing the measured length. ..................................... 127
Figure A21. An example of a workspace showing the measured area. ......................................... 127
Figure A22. An example of the “Convert Shapefile to Grid” tool’s main dialog box. ...................... 128
Figure A23. A typical inquiry message about adding the new grid to the workspace. ................... 130
Figure A24. An example of the prompt for a short name for the grid file. ..................................... 130
Figure A25. An example of a workspace and legend after converting a shapefile to a grid and adding it to the workspace and legend. ..................................................... 130
Figure A26. The Extract Subset Tool dialog box. ......................................................................... 131
Figure A27. Grid and shapefile schematic for help with using the “Extract Subset Tool.” ............... 132
Figure A28. An example of the new grid created with the “Extract Subset Tool.” ........................ 133
Figure A29. The “Map Grid Tool” dialog box. .................................................................133
Figure A30. The “Slope Grid” form for the Map Grid Calculations Tool. .........................134
Figure A31. An example of a slope grid as displayed in the legend and workspace. ..........135
Figure A32. The “Multiply” form for the Map Grid Calculations Tool. ...............................135
Figure A33. An example of a new grid created for a multiply operation. .............................136
Figure A34. The AOI shapefile used in this tutorial. .........................................................137
Figure A35. An example of the “Convert Shapefile to Grid” tool for converting an AOI shapefile to a grid .................................................................138
Figure A36. An example of an AOI converted to a grid as shown in the legend and workspace. ........................................................................................................138
Figure A37. An example of converting a soil texture shapefile to a grid. ..............................139
Figure A38. An example of the MUKEY soil texture classification information in a DBF file. ........................................................................................................140
Figure A39. An example of extracting a subset from the previously created grid. ................140
Figure A40. An example of soil texture grid that coincides with the AOI. ..............................141
Figure A41. An example of a land cover grid that encompasses the user’s AOI. ....................141
Figure A42. The “Extract Subset” tool’s main dialog box for the land cover grid. ..................142
Figure A43. The resulting land cover grid that coincides with the user’s AOI. .........................142
Figure A44. The Map Grid Calculations Tool/Create a Slope Grid from a DEM main dialog box. .............................................................................................................143
Figure A45. An example of the resulting slope grid that encompasses the user’s AOI. ............143
Figure A46. An example of the Extract Subset tool showing the inputs for creating a slope grid that coincides with the user’s AOI. .........................................................144
Figure A47. An example of the resulting slope grid that coincides with the user’s AOI. ............144
Figure B1. The Soil Properties tab of HGCT in Point mode. ................................................146
Figure B2. The Erosion tab of HGCT in Point mode. ..........................................................147
Figure B3. The Hydrology tab of HGCT in Point mode. ......................................................148
Figure B4. The format of the precipitation file. .....................................................................150
Figure B5. The format of the mean and maximum temperature file. ....................................150
Figure B6. The Darcy Velocity tab of HGCT in Point mode. .................................................150
Figure B7. The Soil Properties tab of HGCT in Spatial mode. ..............................................152
Figure B8. The soil texture table associated with the soil texture grid file. ............................153
Figure B9. The Erosion tab of HGCT in Spatial mode. ........................................................154
Figure B10. The Landuse Table associated with the Landuse Grid file. .................................155
Figure B11. The Hydrology tab of HGCT in Spatial mode. ..................................................156
Figure B12. An example CN table for the Hydrology tab of HGCT in Spatial mode. ..............157
Figure C1. The Constituent Database Editor main form. .....................................................159
Figure C2. The Constituent Database Editor’s File menu. .....................................................160
Figure C3. The Constituent Database Editor’s Tools menu. ................................................161
Figure C4. The Constituent Database Editor’s Help menu. ..................................................161
Figure C5. The FRAMES description file prompt for a New database. .................................162
Figure C6. The initial form for a New database. .................................................................162
Figure C7. The Edit Constituent Properties tab for a New database ....................................................... 163
Figure C8. The dialog box for a New constituent .................................................................................. 164
Figure C9. An example of the Identification properties for a new constituent ....................................... 164
Figure C10. The Properties sub-tab ..................................................................................................... 165
Figure C11. The dialog box for selecting, adding, or editing a reference for a constituent parameter value .......................................................... 166
Figure C12. The dialog box for estimating constituent properties ......................................................... 167
Figure C13. An example showing the specification of degradation products for a constituent .......... 168
Figure C14. An example for TNT showing the Degradation Chain sub-tab ........................................... 169
Figure C15. The Property Criteria Wizard ............................................................................................ 170
Figure C16. The Property Criteria Wizard showing usage of the View only Properties with Criteria’ checkbox ........................................................................................................................................ 170
Figure C17. The Property Criteria Wizard showing usage of the View only Populated Constituents checkbox ........................................................................................................................................ 171
Figure C18. The Add New Criteria dialog box ........................................................................................ 172
Figure C19. The Property Criteria Wizard dialog box after adding a new criterion for the CLKD parameter ........................................................................................................................................ 172
Figure C20. An example of the References dialog box for selecting a reference associated with a parameter’s criterion ........................................................................................................................................ 173
Figure C21. The Benchmark Database Editor main form ...................................................................... 174
Figure C22. The Benchmark Database Editor’s File menu .................................................................... 174
Figure C23. The Benchmark Database Editor’s Help menu ................................................................ 175
Figure C24. The Benchmark Database Editor’s Add Constituent dialog box ........................................... 176
Figure C25. The Benchmark Database Editor’s Sources tab ................................................................ 177
Figure C26. The Benchmark Database Editor’s Add Source dialog box ................................................. 177
Figure C27. The Benchmark Database Editor’s Notes tab ................................................................... 178
Figure C28. The Benchmark Database Editor’s Add Note dialog box ..................................................... 178
Figure C29. The Benchmark Database Editor’s Benchmarks tab .......................................................... 179
Figure C30. The Benchmark Database Editor’s Add Benchmark dialog box ......................................... 179
Figure C31. The Benchmark Database Editor’s Select Constituent form for a benchmark .................... 180
Figure C32. The Benchmark Database Editor’s Select Media form for a benchmark ............................. 181
Figure C33. The Benchmark Database Editor’s Select Unit form for a benchmark ................................. 181
Figure C34. The Benchmark Database Editor’s Select Receptor form for a benchmark ......................... 183
Figure C35. The Benchmark Database Editor’s Select Source form for a benchmark ............................ 184
Figure C36. The Benchmark Database Editor’s Select Note form for a benchmark ............................... 184
Figure C37. The Munitions Database Editor main form ....................................................................... 185
Figure C38. The Munitions Database Editor’s File menu .................................................................... 186
Figure C39. The Munitions Database Editor’s Add menu ................................................................... 186
Figure C40. The Munitions Database Editor’s Edit menu ................................................................... 186
Figure C41. The Munitions Database Editor’s Help menu ................................................................... 187
Figure C42. The Munitions Database Editor’s New database message .................................................. 187
Figure C43. The Munitions Database Editor’s Add Munition dialog box ............................................. 188
Figure C44. The Munitions Database Editor’s Add Munition Constituents dialog box. ................. 189
Figure C45. The Munitions Database Editor’s Select Munition Constituents form. ...................... 190
Figure C46. The Munitions Database Editor’s Edit or Delete Munition” form.............................. 191
Figure C47. The Munitions Database Editor’s “edit munition” form. .............................................. 191
Figure C48. The Munitions Database Editor’s Edit or Delete MC form........................................... 192

Table

Table A1. GIS Functions/Tools of TREECS. .................................................................................. 120
Preface

This study was funded by the U.S. Army’s Environmental Quality and Installations (EQI) Research Program. This report was prepared by Jeffrey Gerald and Drs. Billy Johnson and Mark Dortch. Dr. Johnson and Jeffrey Gerald worked in the Water Quality and Contaminant Modeling Branch (WQCMB), Environmental Processes and Engineering Division (EPED), Environmental Laboratory (EL) of U.S. Army Engineer Research and Development Center (ERDC). Dr. Dortch was under contract with Los Alamos Technical Associates (LATA), which was under contract to the ERDC. The study was conducted under the general direction of Dr. Beth Fleming, Director of the EL; Warren Lorentz, Chief, EPED, EL; and Dr. Dorothy H. Tillman, Chief, WQCMB, EL. John Ballard was Program Manager of the EQI Program, EL. Dr. Elizabeth Ferguson was Technical Director.

Personnel from the U.S. Army Environmental Command (AEC) and the U.S. Army Public Health Command (Provisional), Army Institute of Public Health (AIPH) provided recommendations for this report. Their assistance is greatly appreciated.

Dr. Jeffery P. Holland was Director of ERDC. COL Kevin J. Wilson was Commander. This report is approved for unlimited distribution.
# Unit Conversion Factors

<table>
<thead>
<tr>
<th>Multiply</th>
<th>By</th>
<th>To Obtain</th>
</tr>
</thead>
<tbody>
<tr>
<td>cubic feet</td>
<td>0.02831685</td>
<td>cubic meters</td>
</tr>
<tr>
<td>degrees Fahrenheit</td>
<td>(F - 32)/1.8</td>
<td>degrees Celsius</td>
</tr>
<tr>
<td>feet</td>
<td>0.3048</td>
<td>meters</td>
</tr>
<tr>
<td>miles (U.S. statute)</td>
<td>1,609.347</td>
<td>meters</td>
</tr>
<tr>
<td>pounds mass</td>
<td>453.59</td>
<td>grams</td>
</tr>
<tr>
<td>slugs</td>
<td>14.59390</td>
<td>kilograms</td>
</tr>
<tr>
<td>square feet</td>
<td>0.09290304</td>
<td>square meters</td>
</tr>
</tbody>
</table>
1 Introduction

Background

The Training Range Environmental Evaluation and Characterization System (TREECS™) is being developed for the Army. It will have varying levels of capability to forecast the fate of munitions constituents (MC) — such as high explosives (HE) and metals — present in and transported from firing/training ranges to surface water and groundwater. The overall purpose is to provide Army environmental specialists with tools to assess the potential for MC migration into surface water and groundwater systems and to assess range management strategies to ensure protection of human health and the environment.

TREECS™ presently has two tiers for assessments. Tier 1 consists of screening-level methods that require minimal data input requirements and can be easily and quickly applied to assess the potential for MC migration into surface water and/or groundwater at concentrations exceeding protective health benchmarks at receptors’ locations. Assumptions, such as steady-state conditions, are made to provide conservative or worst-case estimates for potential receptor media concentrations under Tier 1. If a potential concern is indicated by a Tier 1 analysis, then there would be cause to proceed to Tier 2 to obtain a more definitive assessment. The formulations for the Tier 1 modeling approach are presented by Dortch et al. (2009).

Tier 2 assessment methods require more detailed site data, and require more knowledge and skill to apply. They can, however, be applied by local environmental staff that have a moderate understanding of multimedia fate and transport. The Tier 2 approach will allow time-varying analyses of both the solid and non-solid phases of MC with dissolution. A time-varying analysis should provide more accurate predictions with generally lower concentrations due to mediating effects of transport phasing and dampening. The Tier 2 modeling approach is described by Dortch et al. (2011a). Tiers 1 and 2 focus on contaminant stressors and human and ecological health end-point metrics.

Proof-of-concept (POC) applications were conducted for Tier 1 and 2 as documented by Dortch et al. (2010 and 2011b). These reports can be used
to gain a better understanding of model inputs and how they can be estimated. The POC reports should be used to supplement this user guide since those reports do not provide any information regarding navigation through TREECS™ user interface screens.

There are numerous help files that can be accessed within TREECS™ to assist the user in application. These help files are intended to supplement and — in some cases — minimize time spent studying this user guide.
2 Getting Started

User and Computer Requirements

General information on TREECS™ and an overview of its capabilities can be accessed from http://el.erdc.usace.army.mil/treecs/index.htm. The software is developed for personal computer (PC) client-based applications, which means all of the programs and files reside on the user’s PC. World Wide Web access is not required to run the software, but is required to access and download the software for installation on the user’s PC. The software downloaded is initiated from the TREECS™ Web site, but at this time only users with a .mil (Department of Defense, DoD users) universal resource locator (URL) in their email addresses will be able to be provided the proper link to commence the download. There are plans to provide a downloadable version of TREECS™ for non-DoD users. The non-DoD version will not include munitions information or loadings in the source area, but the user will be able to input generic source loadings.

The user should have a technical background with some education or training in the environmental sciences or in engineering. It is preferable for the user to have some experience in systems modeling. Application of Tier 1 does not require as much technical knowledge and experience as does Tier 2. It is also recommended that the user be fairly adept at PC usage.

TREECS™ requires a minimum of 900 megabytes (MB) of hard disk space and two gigabytes (GB) of random access memory (RAM). Additionally, the user should have MS Excel™ installed on his/her system. All additional software required is packaged into the TREECS™ install. TREECS™ has been tested for Windows XP and Vista/Windows 7 operating systems.

Acquiring and Installing Software

Requests for the TREECS™ software must be made on the TREECS™ Web site (http://el.erdc.usace.army.mil/treecs/index.htm). Authorized users or system administrators will then receive an email with download instructions. When downloading the software, the installation file should be saved to the user’s hard disk storage drive. If the user has PC system administrator privileges, then he/she can install the programs by running the install package that was downloaded. Double clicking the install file will launch
the install. If the user does not have system administrator privileges, then the system administrator will have to be contacted to install the software.

After installing the software, it is highly recommended that the user use a central project directory for all his/her projects. It is further suggested that the central directory adhere to the disk operating system (DOS) 8.3 naming convention and be located just off of a root directory (e.g. C:\TrxCases, D:\TrxCases, etc.) The user can then create cases in this directory. If a system administrator is required to install the software, then he/she should create this directory after installing the software and should grant sufficient privileges to the user to read, write, modify, and create files and sub-directories in this directory. The DOS 8.3 naming convention is suggested because some of the legacy models used in TREECS™ have this requirement.

**Launching TREECS™**

After TREECS™ has been installed, there should be an icon on the user’s PC desktop for launching TREECS™. The icon will be labeled “Launch TREECS™.exe.” Double clicking this icon will launch the program, and the main screen of the user interface (UI) will come up on the PC screen.

When TREECS™ is first started, a *Getting Started* dialog box appears. This dialog box provides some guidance to the new user about how to get started using TREECS™. All tabs in TREECS™ are initially locked until the user creates a new project or opens an existing project. The dialog box informs the new user about this fact. The user can check the “Do not show this message again” checkbox to prevent this dialog box from being displayed in the future.

**File Hierarchy**

The TREECS™ file hierarchy is such that the project file (.trp extension) contains all of the basic TREECS™-related information for the application. This includes the name of the installation upon which the application is being performed and any area of interest (AOI) shapefile that may represent the AOI used for the application. The project file is only updated when the user saves (or performs a *Save As*) the project using the *File* menu of TREECS™. In the project file, the installation is a key component of the analysis. Therefore, when the installation is selected or changed, this will cause any existing information in the TREECS™ UI to be reset in terms of constituents and munitions. However, if the user does not save the project
with these changes to the selected installation, then there will be no changes made to the project file on disk. An AOI represents some particular area of interest at an installation. TREECS™ keeps track of all AOI shapefiles that the user creates for an installation and as such, any existing AOIs created for an installation can be selected by the user at any time by using the “Select existing AOI” button on the first tab of the TREECS™ UI. It is left up to the user to ensure that all munitions usage and other site information are specific to a given AOI. TREECS™ can presently handle only one AOI per application. Thus, if there are multiple AOIs of interest, then each would constitute a separate AOI and a separate application.

The Hydro-Geo-Characteristics Toolkit (HGCT) creates a subdirectory based on the project name that resides within the parent project directory. If the HGCT is used for an application, the primary extensible markup language (XML) file (which has the project name with the .xml extension) and various supporting files will be created in the HGCT subdirectory.

There are many other files that compose an application besides the project file (.trp); for example, .wls, .wrn, .win, .xml, .sup, .fluxes, .rdf, .scf, .wff, .wcf, .bak, .ref, .def, and .gid. Out of these files, the .trp, .gid, .ref, .sup, .xml, and .nts files, as well as all files in any associated HGCT subdirectory, are needed to transfer an application to someone else in order to provide him/her with the full capability to open, change, and reapply that case study on another computer with TREECS™ installed. If the user’s case contains any user-defined databases, then those databases will be required as well. A package/unpackage utility will be added to TREECS™ that will automate the task of archiving/dearchiving files for sending/receiving cases to/from other users.
3 Main Screen Features

The main screen of the UI is shown in Figure 1. There are basically two major features, the blue menu bar at the top and the screen selection tabs just underneath the menu bar.

![Figure 1. Main screen of the TREECS™ UI.](image)

**Menu Bar**

**File**

The options under File are:

- New
- Open
- Save
- Save As
- Exit
**New** is used to initiate a new application. If selected, the user is prompted to provide a file name and location for storing the application file, which has the extension .trp. It might be desirable to create a special directory for a particular set of applications. *Note that TREECS™ contains several legacy models and that some of these models use the DOS 8.3 naming convention. It is therefore suggested that the user restrict his/her TREECS™ project directories and filenames to the DOS 8.3 naming convention in order to avoid any problems.*

After entering the file name and clicking Open, the user is asked to set the map unit for geographical information system (GIS) data. The choices are degrees, meters, or feet. The unit selected should be consistent with all GIS files that are used within the application.

**Open** under File is used to open an existing TREECS™ project. The user is queried to navigate to the appropriate directory and open the application file of interest. A standard Microsoft file open dialog box is used.

**Save** is used to save an open project. The project will be saved with the .trp extension.

**Save As** is used to save a project under another name. A standard File dialog will appear that will allow the user to select the directory and project name under which the project will be saved. If the user has an HGCT project associated with the current TREECS™ project, then it will be automatically saved as well under the new name in a subdirectory based on the Save As path/filename prefix. For example, if the user's current TREECS™ project is "\temp\myProj1.trp" and the user does a Save As "\temp\myProj2.trp," then in addition to all TREECS™-associated project files being copied under the new path/filename, any corresponding HGCT project will be copied as well. Thus, "\temp\myProj1" will be copied as "\temp\myProj2" and the associated HGCT XML file, "\temp\myProj1\myProj1.xml," will be copied as "\temp\myProj2\myProj2.xml." Other supporting HGCT files will be copied as well into "\temp\myProj2."

**Exit** is used to close the application and exit TREECS™.

**References**

The References feature in TREECS™ allows the user to record the sources of information and data used in an application. The References menu has
options for viewing, printing, and editing project references. Each of these is described below.

**View** launches a supporting application that allows the user to view the current project’s references, if the user has supplied references for the project. All references are initially entered into the project via each model UI which is described elsewhere. The View mode of the reference support application is shown in Figure 2 below. The Previous and Next buttons on the dialog box allow the user to move through the individual project references.

![Figure 2. The View dialog box of the References feature.](image)

**Print** launches a supporting application that allows the user to print the current project’s references. The Print mode of the reference support application is shown below in Figure 3. The Previous and Next buttons on the dialog box allow the user to move through the individual project references. The Print button allows the user to capture the screen of the currently displayed reference and send it to the default printer. The File menu in this dialog box also contains a Print All item that allows the user to print all references in report form to the default printer.
**Edit** launches a supporting application that allows the user to edit the current project's references. This screen looks like the View screen with the exception that the short and full reference boxes are active, and the text within them can be changed. The user can edit either or both of the short and full references.

**Reports**

The Reports feature in TREECS™ provides the user with the capability to generate a report of all inputs used in a given scenario. The Reports menu has only one option, input summary report, and is described below.

**Input Summary Report** launches a dialog box like that shown in Figure 4 and allows the user to select which type of inputs to include in the report for the scenario. The input types include general information (e.g., installation selected, installation description, selected AOI shapefile, tier analysis, etc.), constituent information (e.g., the constituent database used, various constituent physical and chemical properties), munition information (e.g., the selected munition database, the munitions selected, the munition usage information), health benchmark information (e.g., the health benchmark database used, health benchmark values, any sources or notes cited), soil model inputs, vadose model inputs, groundwater model inputs, and surface water model inputs. By default, all applicable options...
are checked and the user should uncheck those which are of no interest for the report. Depending on the user's scenario, some model input options in the dialog box may be disabled if they are not applicable to the current scenario. After selecting the desired options for the report, the user can click the OK button to generate the report in Crystal Reports™ or click the Cancel button to close the dialog box. An example input summary report is shown in Figure 5. The CrystalReport viewer allows the user to export the report in several different formats including Crystal Reports, Adobe™ PDF, Microsoft® Excel™, Microsoft® Excel™ Data Only, Microsoft® Word™, and Rich Text Format.

**Tools**

There are eight items under Tools:

- Notes Editor
- Hydro-Geo-Characteristics Toolkit (HGCT)
- Constituent Database Editor
- Benchmark Database Editor
- Munitions Database Editor
- Add/edit user-specified tool
- Lead solubility
- Copper solubility
Figure 5. An example screen of the Input Summary Report.

Tools items are intended to help the user set up or modify his/her application. Each of the Tools items is discussed below.

**Notes Editor** will launch a dialog box that allows the user to enter notes and miscellaneous information about a scenario. This feature is intended to provide some flexibility to the user to enter basic information about inputs that are specific to the TREECS™ user interface and not to the models used within TREECS™. Models have their own referencing system, which can be viewed, printed, or edited through the corresponding Reference menu items of TREECS™. The user should note that if the user supplies a reference in this editor that it is only applicable to TREECS™ and not to the model inputs. However, the user can enter a reference in this editor as well as entering the same reference for a model. The file extension for this editor is “.NOT” and has the same filename prefix as the user’s current project file, whereas the model references have a “.REF” file extension. These files are separate and not interchangeable.
**Hydro-Geo-Characteristics Toolkit (HGCT)** is a tool that allows the user to estimate soil and hydrologic variables needed for modeling, including:

- Soil porosity, volumetric moisture content, dry bulk density, and saturated hydraulic conductivity
- Average annual soil loss rate due to erosion
- Average annual precipitation, rainfall, runoff, infiltration, evapotranspiration (ET), air temperature, and number of rainfall days
- Darcy velocity

HGCT has two options for being launched, spatial and point. If the user plans to use detailed spatial data in his/her analysis, then the spatial option should be used. If a single point or site-average inputs are desired, then the point option should be used. Note that the user should be certain that he/she has already created any necessary GIS grid files that he/she will need before using the tool in spatial mode. Usage of the HGCT is described in more detail in Appendix B. Values of variables estimated by the HGCT can be automatically transferred to the Tier 1 and 2 soil models.

**Constituent Database Editor** is a tool that allows the user to create his/her own constituent database that can then be used in the TREECS™ system by selecting the User-Defined Constituent Database option, which is described under the Site Conditions/Constituent Selection tab. Only user-defined constituent databases that have been created using this tool are allowed in TREECS™. The editor allows the user to specify constituent physical/chemical properties as well as various toxicity properties and bioaccumulation factors that are not presently used in TREECS™. This editor can only be used with the FRAMES constituent database format. The user can either create a new database or open a copy of the FRAMES constituent database, which can be found as \Prog Files\TREECS\Databases\CopyOfFui.mdb. If a new database is created, the constituent list is blank. In either case, the user can add new constituents or change values to existing constituents. Users can save their databases with whatever names they choose, and then select them for their application as described in Site Conditions/Constituent Selection. Use of the Constituent Database Editor is described in more detail in Appendix C.

**Benchmark Database Editor** allows the user to create his/her own health benchmark database. This database can then be readily used in
TREECS™ as a user-defined benchmark database, which is described under the DoD Target Health Benchmarks tab. The user-defined benchmark database adheres to the format of the Department of Defense (DoD) health benchmark database. The user can either create a new database or open a copy of the health benchmarks database that is delivered with TREECS™ and can be found as \Prog Files\TREECS™\TreecsBenchmarks Revised.mdb. If the user creates a new health benchmark database, the media, receptors, and units are pre-populated for the user and are noneditable. This prevents the introduction of nonsupported values for these data tables into the database which would affect their processing by TREECS™. Using this editor, the user will be able to add new constituent benchmarks, change values for existing constituents, or delete benchmarks, constituents, sources or notes. Use of the Benchmark Database Editor is described in greater detail in Appendix C.

**Munitions Database Editor** allows the user to create his/her own munitions database that can then be readily used in TREECS™ as a user-defined munitions database, which is described under the Site Conditions/Operational Inputs tab. This editor is used to add/edit munitions and their component constituents. The user can either create a new database or open a copy of the munitions database that is delivered with TREECS™ and can be found as \Prog Files\TREECS™\Databases\Munitions.xml. If a new database is created, the munitions list is blank. In either case, the user can add new munitions or edit values for existing munitions. Users can save their databases with whatever names they choose, and then select them for their application as described in Site Conditions/Operational Inputs. Use of the Munitions Database Editor is described in more detail in Appendix C.

**Add/edit user-specified Tool** will launch a dialog box like that shown in Figure 6. Through this dialog box, the user can add standalone tools to the TREECS™ tools menu as well as edit/delete any that have been previously added by the user. The dialog box also has a feature that allows a user's tool to be listed in the tools menu, but the tool exists in a disabled state. To add a new tool, supply a short name for the tool and the complete path and filename of the executable for the associated tool in the appropriate fields of the dialog box (the Browse button can be used to browse to the desired executable) and click the Add button. To edit an existing user tool, select the "Edit existing tool" radio button and then find and select the short name of the tool to be edited in the existing tools combo box. This will display the
associated information for the selected tool in the “Existing tool short name” along with an Active box and Executable field with the path where the executable resides. The appropriate changes can be made and the Update button or Delete button is clicked. Click Cancel to exit the dialog box without saving any changes or click OK to save the changes.

**Lead solubility and Copper solubility** are two user-specified tools that have been added to the release version of TREECS™. Each of these tools are Excel spreadsheets obtained from a Stevens Institute of Technology Web site for estimating the solubility of lead and copper in water given the pH, alkalinity, and total dissolved solids of the water. Use of these spreadsheets is discussed in Appendix A of the report by Dortch et al. (2011b).

**Web sites**

This menu item is for convenience so the user can quickly access various Web sites of interest when using TREECS™. There are no linkages between these Web sites and the TREECS™ modules. The Munitions Items Disposition Action System (MIDAS) Web site is included with the TREECS™ install along with the Web site for Visual MINTEQ, which is a user-added Web site also included with the install. MIDAS can be used to obtain information on munitions components and constituent masses, but
the user must have a MIDAS account. MIDAS is maintained by the Defense Ammunition Center (DAC). Visual MINTEQ is software for chemical equilibrium speciation modeling and could be helpful for estimating solubility for various inorganic constituents, such as metals. The use of Visual MINTEQ for estimating the solubility of lead and copper in water is described in Appendix A of the report by Dortch et al. (2011b).

**Add/Edit User Web site** under Web sites will launch a dialog box like that shown in Figure 7. Through this dialog box, the user can add Web sites to the TREECS™ Web sites menu as well as edit/delete any that have been previously added by the user. The dialog box also has a feature that allows a user's Web site to be listed in the Web site menu, but be in a disabled state. To add a new Web site, supply a short name for the Web site and the URL for the associated Web site in the appropriate fields of the dialog box and click the Add button. To edit an existing user Web site, select the "Edit existing Web site" radio button and then find and select the short name of the Web site to be edited in the existing Web sites combo box. This will display the associated information for the selected Web site in the "Existing Web site short name," along with Active checkbox, and URL fields where the Web site can be found. After making the appropriate changes, click the Update button or Delete button. Click Cancel to exit the dialog box without saving changes or click OK to save the changes.

![Add/Edit User Websites dialog box](image)

*Figure 7. The Add/Edit user Web sites dialog box.*
Options

The Options item is provided on the menu for selecting the default models that will be used in an analysis (which is dependent upon the currently selected analysis Tier) as well as setting the working directory. Each of these menu items is described below.

**Project** has a Model Selection sub menu that allows the user to select the default models that will be used in the current analysis when multiple models are available for a given media. Note that the model selection is dependent on the currently selected analysis Tier. Tier 2 has two surface water models available for the user to select between. These are RECOVERY, [http://el.erdc.usace.army.mil/elpubs/pdf/trel01-3.pdf](http://el.erdc.usace.army.mil/elpubs/pdf/trel01-3.pdf) and Contaminant Model for Streams (CMS), [http://el.erdc.usace.army.mil/elpubs/pdf/eltr07-1.pdf](http://el.erdc.usace.army.mil/elpubs/pdf/eltr07-1.pdf). Information about each highlighted model can be obtained by clicking the Info button. The Model Selection dialog box in shown in Figure 8 for a Tier 2 scenario.

![Model Selection dialog box](image)

**Set Working Directory** will allow the user to set a working directory for the project files. The working directory is the directory that TREECS™ will go to when the user initiates File/New or Open. The dialog box is shown in Figure 9. The user simply browses to or enters the path of the directory be used as the default, and then clicks OK to set the path or Cancel to exit without resetting the directory.
Help

The Help menu item contains two options, Help and About TREECS™. Each of these items is described below.

Help opens a help file for the entire TREECS™ system. Much of the information in this report is in the help file. There are other help files as well that reside in various components of TREECS™.

About TREECS™ will bring up a dialog box that shows information about the version, last modification date, general information, and disclaimer information. The dialog box should look similar to that shown in Figure 10.

![Figure 9. The dialog box for setting the default TREECS™ working directory.](image-url)

![Figure 10. The typical About TREECS™ dialog box.](image-url)
Screen Selection Tabs

Each of the tabs and their inputs screens are described in this section.

Installation/AOI Description

*Installation*: The installation can be selected from the Select Installation button shown in Figure 11. The “Installation description” textbox on tab 1 of TREECS™ can be populated by the user if so desired. If the Select Installation button is clicked, then it will bring up a dialog box in which the user can select the installation of choice where GIS files specific to the installation will be automatically loaded into TREECS™ (if the GIS files for the installation have been developed and stored).

The user can add/edit basic information for an installation using the dialog boxes that appear when the “Add/Edit installation” button is clicked. These subsequent dialog boxes allow the user to change the name of an installation, set a flag as to whether an installation should show up in the list of available installations, set the system directory used for an installation's GIS files, and add/delete GIS files in the installation directories. One caveat is
that the system directories that TREECS™ uses/recognizes must reside in the TREECS™ installation directory.

Note that located throughout the TREECS™ user interface there are small blue icons with question marks in the center located near several user inputs. The user can place the mouse over these icons and get some short help information about that particular input item. Also note that the Help button located on each tab of the user-interface will provide additional technical help about the input items on that particular tab. There is a help file specifically for this input screen located on the right-hand side of the screen that provides additional information regarding the use of the installation features.

**AOI:** An existing AOI can be selected from the Select Existing AOI button shown or a new AOI can be created using the AOI tools in the GIS Functions/Tools palette. Selecting an existing AOI will bring up a dialog box to select the AOI. The user can then select the AOI, and the associated shapefile for the AOI will be loaded into the TREECS™ GIS. The “AOI description” textbox on the first tab screen of TREECS™ can be populated by the user if so desired. Multiple AOIs may be applied for a given installation, but each application can use only one AOI. All AOI shapefiles created by the GIS AOI tools (i.e., AOI by rectangle or AOI by polygon) of TREECS™ will reside in a User AOIs subdirectory of the currently selected installation, which in itself resides in the TREECS™ installation directory.

**GIS:** The TREECS™ application contains GIS functionality mainly through implementation of the MapWindow's [MapWindow-GIS ActiveX control](http://www.mapwindow.org/). Various GIS files are supported, such as shapefiles and raster grids. GIS files are loaded into the workspace and legend. The GIS Functions/Tools panel contains functions/tools for performing such things as opening individual files, saving files, grid re-sampling, zooming in, zooming out, panning, creating an AOI as a rectangle, creating an AOI as a polygon, measuring length and area, converting a shapefile to a grid, extracting a subset from a grid, and performing map calculations (such as creating a slope grid and performing simple addition, subtraction, multiplication, or division on a grid). Grids and Shapes can be checked or unchecked to turn them on or off. By right clicking the mouse on a grid or shapefile, the user can change the graphical properties of the displayed grid/shape, such as changing the color. The GIS usage is explained in more detail in Appendix A of this report. There is also a tutorial in Appendix A for
using the GIS features for developing grid files needed for a spatial application of HGCT.

**Tier Analysis Selection**

The tier analysis type is selected on this screen. Tier 1 assumes steady-state conditions and limited user input, whereas Tier 2 is a time-varying analysis with consequently more input data. The input screen for this tab is shown in Figure 12. In addition to selecting the tier, the user must check which receiving water media are of interest (e.g., surface water, groundwater, or both). Only one groundwater well can be a receptor target for output when applying Tier 1. When applying Tier 2, up to 5 wells can be a receptor target, and the well ID for each well must be entered.

![Figure 12. The Tier Analysis Selection tab of TREECS™.](image)

**Site Conditions**

**Constituent Selection**

The munitions constituent (MC) selection is performed by the user on the Site Conditions and Constituent Selection tabs of TREECS™ as shown in Figure 13. The user must first select a constituent database to use for his/her analysis. The options are the FRAMES Constituent Database, the
Army Range Constituent Database, the Risk Assessment Information System (RAIS), or a User Defined Constituent Database. The last option should have been created with the Tools menu's Constituent Database Editor application described previously and in Appendix C. The user must enter or browse to the path of the user-defined constituent database, and then Load/Reload Database.

Once a database has been selected, the available constituents list box is populated with the available constituents. The user then selects the desired constituents for his/her analysis. **Note that switching from one constituent database to another removes all existing selected constituents from the analysis.** The user can use the Search feature to find a constituent and can search by either the constituent name or the Chemical Abstract System Registry Number (CASRN). To select a constituent, click the constituent name (CASRN) in the available list and next click Select. Information in the database for a highlighted constituent can be viewed by clicking the Info button. The “List by CASRN (name)” checkbox is used to change the ordering of constituent name (CASRN). The default is for the constituent name to be listed first followed by the CASRN.
in parentheses. Checking this checkbox will reverse the ordering in the available constituents list box and the selected constituents list box.

The Framework for Risk Analysis in Multimedia Environmental Systems (FRAMES, http://mepas.pnl.gov/FRAMESV1/index.stm) was developed by the Department of Energy’s (DOE) Pacific Northwest National Laboratory (PNNL). FRAMES contains an MS Access constituent database for toxicity, physical/chemical properties, bioaccumulation, and transformation factors for chemicals and radionuclides. The database contains approximately 650 chemicals and 229 radionuclides. The chemical and physical properties portions of the database are available for use in TREECS™ for specifying these properties of constituents. These constituent chemical and physical properties are subsequently used by the system’s models.

The Army Range Constituent Database was developed for the U.S. Army Environmental Command (AEC) in 2002 (http://el.erdc.usace.army.mil/elpubs/pdf/trel02-27.pdf) and was enhanced in 2005 (http://el.erdc.usace.army.mil/elpubs/pdf/trel05-16.pdf) to provide constituent properties for MC from multiple sources within a new database format. The enhanced version of the database is available for use in TREECS™ for constituent physical and chemical properties (e.g., molecular weight, Henry's Law Constant, water solubility, etc.). When multiple properties are available for the same constituent, the user must select a single property to be used by the system models. When each constituent is selected, a dialog box appears listing each parameter, the parameter value, its units, a reference for the value, the source of the data, and the type of data (such as calculated or experimental). The user must check the box next to each parameter he/she wants to use in his/her application. For parameters with multiple values, each value is shown, but only one can be chosen.

RAIS (http://rais.ornl.gov/tools/profile.php) was developed by Oak Ridge National Laboratory. TREECS™ allows the user to use a local MS Access version of the RAIS database in his/her analysis for obtaining constituent chemical and physical properties for use by the system models. The TREECS™ local MS Access version of the RAIS database has values from the Web-based version of RAIS that existed circa 2007 when RAIS had only one value for each constituent-parameter.

A User-Defined Constituent Database can be used in TREECS™ by selecting the appropriate option and then supplying the database filename.
The user must have created his/her constituent database based on the FRAMES constituent database format. This can be done by selecting the TREECS™ Tools menu and the Constituent Database Editor menu item. Note that included in the TREECS installation is a user-defined constituent database that includes all of the constituents in the FRAMES database as well as two additional constituents (potassium perchlorate and sodium perchlorate) and some more reasonable parameter values for RDX, TNT, lead, copper, and antimony. This database was created to support the POC applications (Dortch et al. 2010 and 2011b), is named “treecs_con.mdb,” and is located in C:\Prog Files\TREECS\Databases. This database may be selected and used as a user-defined database if so desired.

The currently selected constituents are shown in the box with the same name. The properties of each may be viewed by clicking the constituent and next clicking the Info button. Likewise, constituents may be removed from the list by clicking the Remove button.

Parameters of constituents can be changed by viewing the properties of the selected constituent (i.e., Currently selected constituents/Info), clicking into the parameter value field, entering the desired value, and clicking OK on the bottom of the constituent information screen when finished. Figure 14 shows this dialog box. Each time a parameter value is changed in this manner, the most recent value will be used in the application. It is emphasized that the altered parameter values are saved only for the current TREECS™ application, and the values are not changed in the constituent database. It is also noted that some parameters can be changed again in specific model UI screens. In such cases, the database value (or the value modified by using “Currently selected constituents/Info” dialog box) is inserted into the model UI initially, but any sequent changes to the database value are ignored since the model UI takes precedence. The model UI must be used to modify the property value for subsequent changes after the initial database value has been modified by a model UI.

**Operational Inputs**

The munitions selection is performed by the user on the Site Conditions/Operational Inputs screen of TREECS™. Figure 15 shows what this looks like in TREECS™ for a Tier 1 analysis, and Figure 16 shows the dialog box for a Tier 2 analysis. The user must first select the type of loading for his/her
analysis. The options are Impact Point or Firing Point. Currently, only Impact Point is available to the user as an option.

![Constituent information dialog box where parameter values can be changed.](image)

Figure 14. Constituent information dialog box where parameter values can be changed.

![Site Conditions/Operational Inputs for a Tier 1 analysis in TREECS™.](image)

Figure 15. Site Conditions/Operational Inputs for a Tier 1 analysis in TREECS™.

Next, the user should check to make sure he/she is using the munitions database he/she desires, the choices being either the default database or a user-defined database. The user can utilize the standard default munitions database that is provided with TREECS™ or he/she may elect to use his/her
own munitions database as long as the user-defined database adheres to the format of the default munitions database. To choose a user-defined munitions database, select the “User defined munitions database” option.

![Image of TREECS™ interface](image)

Figure 16. Site Conditions/Operational Inputs for a Tier 2 analysis in TREECS™.

This will cause the screen to change; it will include additional inputs for defining the user-defined munitions database along with a button to browse for the database and a button to perform the loading of the data from the database. These new fields associated with a user-defined munitions database can be seen in Figure 16. After loading the database, the “Munitions master list” will populate with the user's munitions from the user-defined database.

The user can search for given munitions in the munitions master list by typing in the partial or complete munitions name, NSN, or DODIC. After entering in the munitions to be searched, click the Find/Find Next... button to begin/resume searching the available munitions list box for the specified munitions. The user selects the desired munitions to be used in his/her analysis by selecting the munitions in the munitions master list and clicking the Select button. This adds the munitions to the selected munitions list.
The Remove button will remove the previously selected munitions from the analysis. The user must first select the munitions to be removed in the “Munitions used at this site/range” list box prior to clicking the Remove button.

Select a munition in the “Munitions used at this site/range” list box and then click the Detailed Info button to bring up a dialog box like that shown in Figure 17. The dialog box shows all constituent information for the selected munitions. The information shown is not filtered at this point for impact or firing point, but instead shows all information in the database for the selected munitions.

Once all munitions of interest have been selected, then the user must provide munitions usage information for each of the munitions. The required input for munitions usage information depends on whether the user is conducting a Tier 1 or 2 analysis. However, most of the required information is basically the same – whichever option the user chooses – with the primary difference being that time-varying information can be used for Tier 2. Information required includes the number of rounds fired per year, dud percentage, low order percentage, high order percentage (calculated from 100 - dud percentage - low order percentage), percentage of duds sympathetically detonated, sympathetic dud yield percentage, low order yield percentage, and high order yield percentage. Yield is defined as the amount of MC totally consumed in the explosion. For Tier 2 assessments, the user must enter the starting year of the simulation and the usage.
information by year. Each of the munitions in the “Munitions usage information” list box must be selected and the usage information entered. The total MC residue loading rate resulting from all of the munitions and their usage can viewed by clicking the View MC Loading Rate button.

It should be noted that the time-varying munitions usage information is stepped, which means that the number of rounds fired/yr and associated information are held constant between time updates. Years can be decimal portions of a year as well as whole numbers or integers. Because downstream models using the munitions usage may handle time-varying data differently, it is prudent to always include the time when munitions use is zero, if there is such a time. As an example, suppose the starting year is 1940, and a particular munition was fired 1,000 times per year for twenty years, was fired 2,000 times per year for the next 20 years, and then was no longer used afterwards. The input table for this usage would look as follows:

<table>
<thead>
<tr>
<th>Time (yr)</th>
<th>Rounds Fired/yr</th>
<th>.....</th>
<th>.......</th>
</tr>
</thead>
<tbody>
<tr>
<td>1940</td>
<td>1000</td>
<td>.....</td>
<td>.......</td>
</tr>
<tr>
<td>1960</td>
<td>2000</td>
<td>.....</td>
<td>.......</td>
</tr>
<tr>
<td>1980</td>
<td>0</td>
<td>.....</td>
<td>.......</td>
</tr>
</tbody>
</table>

**DoD Target Health Benchmarks**

The health benchmark database contains concentration reference values for the following media-receptor types:

- Sediment (fresh) – ecological
- Sediment (marine) – ecological
- Surface water (fresh) – ecological
- Surface water (marine) – ecological
- Surface water (fresh) – human
- Groundwater – human

If a media concentration is greater than the reference value (i.e., benchmark), then there is cause for further investigation. It is noted that the benchmarks in the DoD health benchmark database are highly conservative screening values that do not denote risk if exceeded but merely indicate the need for additional study.

The user first must select a target health benchmark database. The user can use the default or create his/her own using the Benchmark Database Editor.
under the Tools menu item. If using the latter, then the user should make
the appropriate selection on the screen and select the Load/Reload button
to load the database. As the user selects constituents for analysis, the bench-
marks are simultaneously pulled from the selected database and displayed
in the data-grid as shown in Figure 18. The application supports the use of

![Figure 18. The DoD Target Health Benchmarks tab.](image)

freshwater and marine surface water/sediment benchmarks, and the
database was created such that some benchmark values depend on the
sediment total organic carbon. Detailed information about a benchmark is
also available in the application by clicking the far left cell of the row of an
MC benchmark in the data-grid for which the information is desired and
clicking the Detailed Info button. An example the dialog box that displays
the detailed information is shown in Figure 19.

The checkbox labeled “Ecological Surface Water/Sediment is marine (as
opposed to freshwater)” is used to have TREECS™ select the appropriate
marine or freshwater surface water or sediment benchmark to use in the
analysis. If the checkbox is not checked, then the application will use
freshwater surface water and sediment benchmark values for ecological
assessment. If it is checked, then the application will use marine surface
water and sediment benchmark values for ecological assessment.
Some sediment benchmark values depend on the sediment total organic carbon (TOC) content, and a sediment TOC value is required. Benchmarks in the data grid that are affected by TOC will update as the user enters or changes the sediment TOC value. Detailed Info for a benchmark will show whether the benchmark value is dependent upon a sediment TOC value.

The health benchmark database does not currently have any benchmark values for soil, but such a placeholder has been added into TREECS™ in case this information is added to the database at some future time. Therefore, this option is currently disabled. Also, the health benchmarks tab/screen is currently being updated to accommodate the input of surface water alkalinity, which is used to compute surface water ecological benchmarks for metals.

**Inputs**

The inputs tab or screen, as shown in Figure 20, is where the user launches each model UI to supply the model input parameters. Each model button is clicked to launch that model’s UI. Non-applicable media for the user’s scenario will have the associated input buttons disabled. A green checkmark is used to denote that all of a model’s inputs are complete, whereas a red X indicates that inputs have not been performed. Changing the MC in an
analysis will cause the status lights to change since a change in constituents will likely mean that model inputs need to be updated for the change as well. The input parameters for each model are discussed in the next chapter.

![Figure 20. The Inputs tab of TREECS™.](image)

**Execute**

The Execute tab of TREECS™, as shown in Figure 21, is where the user actually runs the models. The user should select the appropriate radio button in the group box and then click the “Run model/models” button to run the model(s). The bottom radio button can be used to run all of the models sequentially.

Similar to that of the inputs, the same system of status symbols and colors are used to indicate the state of the model execution. Red X indicates that the model has not been run. A white checkmark in a yellow circle indicates that something has changed which could affect the model output and as such, the model needs to be rerun. This is typical when changes are made to the soil model's input and it is rerun, which will affect all of the other models’ output. A green checkmark indicates that the model has been run and output is available for viewing. After each model runs and if a bench-
mark is exceeded, a pop-up window displays the media, receptor-type, and MC for which the concentration exceeds the health benchmark.

Note that the individual model execute status is saved in the project file. Should the user copy a project from one PC to another, then the status may not actually be indicative of whether there is actually output for a given model. If the user copies a project from one PC to another, then he/she should rerun the models to obtain the model output prior to viewing any model results.

Uncertainty

Sensitivity and uncertainty (S/U) is only applicable in Tier 2 analyses of TREECS™ and the fields on the tab are disabled in Tier 1. The S/U module will allow the user to declare selected inputs as uncertain or sensitive. Statistical distributions and the distribution parameters must be specified for each uncertain input variable. The user also defines which outputs to monitor to assess variability, such as groundwater MC concentration for specified years. The number of Monte Carlo realization simulations is also specified along with the random seed. Following the Monte Carlo simula-
tions, the S/U module calculates the cumulative probability distributions of the monitored outputs and attributes of those distributions. For example, the user can examine the upper and lower 95% confidence limits of predicted groundwater concentrations versus time.

The uncertainty tab is shown in Figure 22. Upon clicking the Specify Uncertain Parameters button, a dialog box is launched requesting that the user select which constituents (MC) to include in the analysis. After the continue button is clicked, the S/U UI appears. There are various screens associated with the UI that are discussed in Chapter 6.

![Figure 22. The Uncertainty tab of TREECS™.](image)

**View Results**

The View Results tab is where the user can view the model results. The screen for this tab is shown in Figure 23. Non applicable media will have the available viewers list boxes disabled. Only applicable media for which model output has been generated will be active. There are a sizeable number of viewers with various options. Thus, Chapter 5 is devoted to explaining the use of viewers.
Figure 23. The View Results tab of TREECS™.
4 Model Inputs

This chapter describes the input screen for the Tier 1 and Tier 2 models of TREECS™. The Tier 1 and 2 soil models are quite different and have different inputs. There is a vadose zone model required for Tier 2 that is not used in Tier 1. The Tier 1 and 2 aquifer models are the same, but many of the inputs for this model have been preset and are not available in the Tier 1 aquifer model UI to promote ease of use. Thus, the UIs for the Tier 1 and 2 aquifer models are different. The Tier 1 surface water model RECOVERY is the same as the Tier 2 version of this model except that many of the inputs have been reset and are not available in Tier 1 UI to promote ease of use. Thus, the Tier 1 and 2 UIs for the RECOVERY model are also different. The surface water model Contaminant Model for Streams (CMS) is available only for Tier 2.

This chapter does not go through each input parameter line by line since each model contains help files. Additionally, the inputs for these models as used for the POC applications are discussed in the Tier 1 and 2 POC reports (Dortch et al. 2010 and 2011b). Tier 2 model inputs are also discussed in the Tier 2 methods report (Dortch 2011a). Additionally, there are technical model documentation reports for each model that are cited in the report by Dortch et al. (2011a). This chapter presents all of the input screens for each model as used for the POC applications. Most of the inputs are self-explanatory and are relatively easy to follow with the help screens. Thus, only the more complex features or unusual caveats are discussed in this chapter.

Tier 1 Models

The input screens for each model as used in the Tier 1 POC application (Dortch et al. 2010) are presented below. The name of this archived TREECS™ input file is T1APH_NS.trp.

Soil Model

The inputs for the soil model as used in the revised Tier 1 POC application are shown in Figure 24. The only input for the Constituents screen, which is not shown, is the solubility for each constituent; these are listed in the report by Dortch et al. (2011b).
A Reference feature is located on the menu bar of the Tier 1 soil model UI. The reference feature allows the user to document or reference each input value and how the value was obtained. When a reference is added, it is automatically numbered and tracked within TREECS\textsuperscript{TM}. The reference number shows up to the right of the data field as shown in Figure 24. The help file for the Tier 1 soil model can also be accessed from the menu bar of the Tier 1 soil model UI. This help file explains the use of the reference feature. The help file located under help menu button of the TREECS\textsuperscript{TM} main screen also explains reference tracking in TREECS\textsuperscript{TM}.

The partition coefficient (K\textsubscript{d}) for each MC can be estimated with the K\textsubscript{d} estimator tool. The initial input screen (Soil Composition/Characteristics tab) of the UI of this estimation tool is shown in Figure 25. From this screen, the user can click the Select/Specify Soil Texture button to launch the screen shown in Figure 26. On the soil texture screen, the user specifies the percents by weight of sand, silt, and clay based on either site-specific measurements or information on soil class. The percentages of sand, silt, and clay will add to 100 percent if the soil class is selected. It is important that the percents of sand, silt, clay, organic matter and iron/aluminum sum to 100 percent. Thus, if there is any organic matter and/or iron/aluminum present, the user must set the percentages on the soil texture screen (Figure 26) low enough to compensate for organic matter and iron/aluminum so that all the percentages sum to 100 percent. The pH should also be entered as shown in Figure 25.
Figure 25. Initial screen of the partition coefficient estimator tool of the Tier 1 soil model UI.

Figure 26. Soil texture/class screen of the partition coefficient estimator tool of the Tier 1 soil model UI.
Percent of soil organic matter OM (see Figure 25) can be estimated from
\[ OM = 1.72 \times OC \], where \( OC \) is the percent of soil organic carbon by weight
\( (g \text{ organic carbon/g soil} \times 100) \). Thus, OM can also be estimated from
\[ OM = 172f_{oc} \], where \( f_{oc} \) is the fraction by weight of organic carbon in the
soil. Organic matter is used for estimating \( K_d \). Iron and aluminum content
refers to oxyhydroxides, which are important relative to sorption
partitioning for some inorganic constituents. There is a data table with a
look-up feature in TREECS™ that relates \( K_d \) (for a select list of inorganic
constituents) to soil pH and the summed percentage by weight of clay,
organic matter, and iron + aluminum content in the soil. If only organic
MC are of interest, the percent of iron + aluminum can be set to zero.
Percent iron + aluminum should refer to that amount that is not contained
within clay.

Once the user has entered the percentages discussed above, the estimator
calculates the \( K_d \) for organic MC or looks up a value from a table for MC that
are inorganic if the inorganic MC is in the database. The values available can
be viewed and selected from the \( K_d \)'s tab by clicking the drop-down combo
box of the “Select Adsorption Coefficient Value” field as shown in Figure 27.
There are three types of values in the combo box: any value that may have
been stored in the constituent database; the value estimated for organic MC
based on soil composition and the organic carbon partition coefficient (\( K_{oc} \));
and the table lookup value for inorganic MC, such as metals.

---

Figure 27. \( K_d \)'s tab of the partition coefficient estimator UI in the Tier 1 soil model UI.
There are help files for the Kd estimator that can be accessed from the main help button on the menu bar (Figure 25) and from the help button shown on the initial screen (Figure 25). The two help files are different, but both provide information about how the Kd values are estimated and how to provide a value for Koc if one was not available in the constituent database. For metals or inorganic MC, the lookup table algorithm uses soil pH and the percents of clay, organic matter and iron/aluminum to determine the appropriate Kd.

**Aquifer Model**

The inputs for the aquifer model as used in the revised Tier 1 POC application are shown in Figure 28 through Figure 30. There are two tabs in the UI, the “Characteristics” tab and the “Concentration Locations” tab. References for input values can be entered and tracked, same as with the soil model and all other models in TREECS™.

There are two tabs or screens that can be selected from the Concentration Locations tab. The “Well Information” screen provides input for the longitudinal distance of the receptor well from the center of the AOI. The “Operational Inputs” screen provides inputs for the perpendicular and vertical distances of the receptor well from the groundwater MC plume centerline and water table, respectively. The default values are zero, which give maximum concentrations at the well. The dispersivity values are automatically computed based on the well location information, or the user can enter values.

![Figure 28. Characteristics screen of Tier 1 aquifer model UI for POC application.](image)
Surface Water Model

The inputs for the surface water model as used in the revised Tier 1 POC application are shown in Figure 31 through Figure 33. References can be entered and tracked for each input, as they can for the other models. The “Options” feature on the main menu of the Tier 1 surface water model UI allows the user to change the length of the simulation and two output frequency parameters. Although the soil model is steady state, the surface water and aquifer models actually run as time-varying models, but their output will eventually reach a steady-state solution due to the steady-state
Figure 31. Morphology and Hydrology screen of Tier 1 surface water model UI for POC application.

Figure 32. System Properties screen of Tier 1 surface water model UI for POC application.
soil model fluxes feeding into them. For some applications, it may be necessary to increase the period of simulation to reach a steady-state solution for surface water.

The user must first choose whether the surface water body is enclosed or a stream (see Figure 31). If the receiving water is an enclosed water body, such as a lake, wetland, or pond, then the user must input the water surface area and average depth, and the residence time will be computed by the model. If the receiving water is a stream, then the user must input the stream average width and depth, and the model will calculate the stream reach length such that the water residence time is approximately 0.1 year, as explained in Appendix A of the report by Dortch et al (2009). The user must also provide the average annual water flow rate and the mixed sediment porosity and fraction of carbon by weight.

Default values are automatically entered for some inputs, such as the wind speed and suspended sediment settling velocity on the System Properties screen (Figure 32). The constituent properties are shown for each MC on the “Constituent/Site-specific Properties” screen (Figure 33). Most of these inputs are automatically entered from information stored in the constituent database and transferred from the “Site Conditions/Constituent Selection” screen of the TREECS™ UI.
The user can enter either $K_{oc}$ or the octanol-water partition coefficient $K_{ow}$ for use in estimating the $K_d$ for each MC. The UI for the Tier 1 surface water model estimates $K_d$ from $K_d = 0.617 f_{oc} K_{aw} = f_{oc} K_{oc}$ where $f_{oc}$ here is the mixed sediment layer fraction by weight of organic carbon that was entered on the “Morphology and Hydrology” screen (Figure 31). The computed $K_d$ values are shown in the bottom panel of the “ Constituent/ Site-specific Properties” screen (Figure 33). The mixed sediment layer $f_{oc}$ is used for the water column and deep sediment layers.

For inorganic MC, such as metals, the user should check the box for “User-defined adsorption coefficients” on the lower portion of the input screen and enter the three values. Both $K_{oc}$ and $K_{ow}$ should be zero for inorganic MC.

**Tier 2 Models**

The input screens for each model as used in the Tier 2 POC application (Dortch et al. 2011b) are presented below. The name of this archived TREECS™ input file is T2APH_NS.trp.

Model selection should be considered whenever beginning a Tier 2 application since the user has a choice of which surface water model to use, whether RECOVERY or CMS. This can be accomplished by clicking the Options button on the TREECS™ menu bar, and then selecting “Project/Model Selection” as described in Chapter 3.

**Soil Model**

There are six input screens associated with the Tier 2 soil model. Each screen is shown in Figure 34 through Figure 40. Inputs for this model are discussed in detail in the reports by Dortch et al. (2011a and 2011b). Some of the inputs can be automatically passed from the HGCT if the HGCT was used to estimate soil and hydrologic parameters. The mass residue loading rates on the “Site Characteristic s” screen are automatically passed from TREECS™ based on data entered for munitions use on the “Site Conditions/Operational Inputs” screen. Other inputs are either based on default values or are entered by the user. If there is any initial MC residue mass at the beginning of the simulation, these values are entered on the first screen (Figure 34). As with the other TREECS™ models, data references can be entered and tracked.
Figure 34. "Site Characteristics" screen of the Tier 2 soil model UI.

Figure 35. "Soil Properties" screen of the Tier 2 soil model UI.
Figure 36. Hydrology screen of the Tier 2 soil model UI.

Figure 37. Fate/Transport Parameters screen of the Tier 2 soil model UI (part 1).
Figure 38. Fate/Transport Parameters screen of the Tier 2 soil model UI (part 2).

Figure 39. Chemical-Specific Parameters screen of the Tier 2 soil model UI.
The vadose zone saturated hydraulic conductivity can be entered on the “Hydrology” screen of the Tier 2 soil model UI (See Figure 36). The vadose zone is immediately beneath the active soil layer. This input is used to estimate the percent of infiltration flow that is diverted as soil interflow. If the vadose zone saturated hydraulic conductivity is greater than the average annual infiltration rate, then the soil interflow is estimated to be zero. The user is also allowed to enter the percent of infiltration that is interflow rather than having the UI estimate it.

There is a $K_d$ estimator tool, very similar to the one in the Tier 1 soil model UI, that can be accessed from the Fate/Transport Parameters screen of the Tier 2 soil model UI. The UI for this $K_d$ estimator tool is shown in Figure 41. This estimator works the same way as the one in the Tier 1 soil model. The user should ensure that the five percentages total 100 percent as before.

The user must supply a value for combined percentage by dry weight of iron (Fe) and aluminum (Al) in the soil. This combined weight represents the total Fe and Al oxyhydroxides present in the soil. Although these oxyhydroxides can constitute the bulk of Fe and Al in the clay, they should be considered separate from the clay since they can have a large effect on metal adsorption. Typical soil content of Fe and Al is 2.6% and 7.5%, respectively. The combined weight percent of clay, organic matter, and Fe + Al oxyhydroxides is used to determine the soil composition, which is used along with the soil pH to look up the metal $K_d$. There are three classes of soil composition percentages for the look-up: <10%; 10% - 30%; and > 30%. The default
value for percent Fe and Al is zero since this is more conservative (i.e., less adsorption implies more movement in water). The user should choose and click the value in the bottom list box that is to be used and then click “OK.”

Volatilization rate can be user specified or estimated by the Tier 2 soil model UI. If estimated, the user should check the “Calculate Volatilization Rate” box on the “Fate/Transport Parameters” screen for the selected MC. This calculation requires the vapor MC diffusion coefficient in air, which is either passed from the constituent database or estimated based upon MC
molecular weight. On the “Fate/Transport Parameters” screen, the user also checks a box if the MC transport includes solid phase particle erosion and selects whether solid phase particles are to be modeled as spherical or cylindrical in shape for dissolution.

Most of the values on the “Chemical-Specific Properties” screen (Figure 39) are automatically passed from the constituent database. Values can be changed on this screen if desired, and if saved the revised values will be preserved in future applications of this .trp case. The water solubility of RDX and TNT can be computed based upon the temperature of the soil-water matrix entered on the “Site Characteristics” screen. The average annual soil-water temperature is typically about 1 °C above the average annual air temperature. The user should double click the input field for solubility next to RDX and TNT and then click “calc” to have the UI estimate the solubility.

There are two model solution options on the “Model Options” screen. If the “Step Type” combo box is clicked, one of the two options of Adaptive Time Step or Constant Time Step can be selected. The adaptive time step option is the default and the safest selection. The value entered for Time Step is not important when the adaptive time step option is selected, since the model automatically calculates the maximum allowed time step for model stability. The value entered for Time Step is very important when the constant time step option is selected. If the time step is set too large, the model will yield incorrect results that can exhibit instabilities. The adaptive time step option should usually be retained or chosen. The simulation period should be long enough to capture all of the transient behavior of interest for soil export to receiving water models, or long enough to deplete soil concentrations.

There are help files associated with all of the input screens of the Tier 2 soil model. Many of these help files go beyond describing the input; rather, they provide tables and other information to aid in selecting values for input parameters.

**Vadose Zone Model**

The three input screens for the Multimedia Environmental Pollutant Assessment System (MEPAS) vadose zone model UI as set up for the Tier 2 POC application are shown in Figure 42 through Figure 44. A fairly extensive help file is provided to assist with these inputs. The “Options” button on the menu bar is for allowing autofill of properties associated with soil class and for changing the ending time (period of simulation). If the default of
Figure 42. Composition screen for the MEPAS vadose model UI.

Figure 43. Characteristics screen for the MEPAS vadose model UI.
zero is retained, then the ending time is automatically determined by the model. This allows all of the constituent flux to pass through the vadose zone and past the aquifer receptor wells, but the ending time will not exceed 10,000 years. If a value other than zero is entered, then the model simulation is run for that length of time.

If the “Soil class” button is clicked on the “Composition” screen, then another screen is launched like that shown in Figure 45 to help the user select the soil class and associated composition. Once the soil class is selected, the values are transferred back to the Composition screen. As with the other models, the user must ensure that all of the composition percentages sum to 100 percent. Several inputs on the “Characteristics” screen are automatically entered based on the soil class selected.

Constituent properties must be entered on the “Constituent Properties” screen and include the partition coefficient, the half-life, and the solubility. Values in the constituent database are automatically transferred to these input fields. The partition coefficient portion of this screen has the same type of tool for estimating this parameter as described for the Tier 1 and 2 soil models. There are basically three options: use value in the constituent database; estimate the value based soil composition and \( K_{oc} \); or look up a
value from a table of inorganic MC $K_d$ values based on soil composition and soil pH. The “Estimate All” button on this screen selects the second option (i.e., compute $K_d$ based on soil composition and $K_{oc}$) for all constituents being modeled. Thus, if any of the MC are inorganic, clicking this button will enter zero $K_d$ values for the inorganic MC. The user can also enter a value rather than choosing one of the three $K_d$ options.

The half-life in groundwater must be entered on the Constituent Properties screen for each MC. If the user wants no degradation, then a very large number, such as $1E+20$ days or years, should be entered.

**Aquifer Model**

The MEPAS aquifer model UI screens are shown in Figure 46 through Figure 50. There is a fairly extensive help file for this model; the help file assists the user with specifying inputs and is accessible from the menu bar. The “Options” button on the menu bar has the same functionality as that button on the vadose zone model. Thus, the model can be run for as long as necessary to pass all the constituent mass through the system — up to 10,000 years — or the user can set the length of the simulation.
Figure 46. Composition screen of the MEPAS aquifer model UI.

Figure 47. Characteristics screen of the MEPAS aquifer model UI.
Figure 48. Concentration Locations screen of the MEPAS aquifer model UI.

Figure 49. Flux Locations screen of the MEPAS aquifer model UI.
The "Composition" and "Characteristics" screens of the MEPAS aquifer model UI (see Figure 46 and Figure 47) are similar to those screens of the MEPAS vadose model UI. Parameter inputs that are related to soil class are automatically filled in if auto-fill is checked under "Options." There is a help file that has a table useful for estimating the effective porosity based on soil texture class. This help file can be found by launching the HGCT under TREECS™ Tools, clicking Help in the HGCT menu, and then selecting Soil Properties/Representative Properties to view the table of values for effective porosity as related to soil texture.

The Concentration Locations screen is where the user enters the receptor well locations. There can be more than one well, but locations must be entered for each. The same location information described for the Tier 1 aquifer model is required. The dispersivity values can be estimated based on well location information as explained by Dortch et al. (2011a), or values can be entered by the user. Entering zero for the lateral (perpendicular to plume centerline) and vertical (depth below water table to well intake) location of the well produces the highest or most conservative well concentrations.
The “Flux Locations” screen is used to specify the longitudinal distance from the center of the AOI to the location where groundwater discharges to surface water. There can only be one such flux location in TREECS™. This screen must be filled out even if there is no groundwater discharge. The flux distance could be the distance from the AOI to the surface water body of interest in the application. In a practical sense, this distance should not be greater than the distance to the surface water body of interest. If the flux distance is less than the surface water body of interest, the constituent mass flux associated with the groundwater discharge is assumed to enter the water body without any further degradation or attenuation that could actually occur between the groundwater discharge location and the water body.

The “Constituent Properties” screen of the MEPAS aquifer model UI is identical to that screen as described for the MEPAS vadose model UI. After all inputs have been entered for each screen, the user should save and exit the UI. When this occurs, the UI shown in Figure 51 is launched for specifying the groundwater discharge flow rate to surface water. There are two options for specifying this flow rate, either specifying the percentage of groundwater flow or specifying the actual groundwater discharge flow rate (m³/yr). The default value for either input is 1.0E-6, which means that it is assumed that there is essentially no groundwater discharge.

If the latter option (i.e., enter flow rate) is chosen, the user must exercise care to ensure that the discharge flow rate does not exceed the total groundwater flow rate at the location of the discharge. It is noted that the total groundwater flow is actually the groundwater flow within the constituent plume. The constituent plume starts out as a thin layer below
the water table with a width equal to the width of the AOI. The plume expands laterally and vertically as it moves downgradient based on the dispersion which is the product of the dispersivity and the Darcy velocity. The groundwater flow within the plume at the flux location is the width and thickness of the plume at that location times the Darcy velocity. Thus, it is not easy to estimate the groundwater flow rate without running the aquifer model and examining the output in the Water Flux File (WFF). A low estimate for this flow would be the product of the AOI width and the Darcy velocity, which assumes a vertical thickness of 1.0 m.

**Surface Water Models**

The RECOVER model was used for the archived application of the Tier 2 POC application. The input screens for this model are described first followed by a description of the input screens for CMS, which was also applied during the Tier 2 POC application as documented by Dortch et al. (2011b).

**RECOVERY**

The input screens for the RECOVERY model are shown in Figure 52 through Figure 58. RECOVERY has a help file for assisting in using its UI that can be accessed by pressing the “Help” button at the bottom of each screen. The “Morphology and Hydrology” screen shown in Figure 52 is used for entering information regarding the total suspended solids (TSS) concentration, $f_{oc}$ of TSS in the water column, water body size (surface area and depth), flow through rate, and water residence time. The top panel of this screen for choosing external loading options is dimmed out within TREECS™ since external loadings are automatically passed from another module. The user should enter three of the four parameters for surface area, depth, flow through, and residence time, and the fourth parameter is calculated by the UI by pressing the “Recalculate” button.

The mixed sediment layer screen of the RECOVERY model UI (Figure 53) is used to define the depths of the mixed layer and the deep contaminated sediments as well as the mixed layer properties. The figure on the left side of the UI screen defines the depth input parameters $L$ and $z$. The deep sediment layers screen (Figure 54) is similar to that of the mixed layer, except that sediment properties can be varied with depth by pressing the “Profile” buttons for porosity, FOC, and specific gravity. If profiles are not entered, then the values entered on the screen are used over the entire deep sediment depth.
Figure 52. Morphology and Hydrology screen of the RECOVERY model UI.

Figure 53. The mixed sediment layer portion of the Morphology and Hydrology screen of the RECOVERY model UI.
Figure 54. The deep sediment layers portion of the Morphology and Hydrology screen of the RECOVERY model UI.

Figure 55. System Properties screen of the RECOVERY model UI.
The “System Properties” screen (Figure 55) is used to enter wind speed, enhanced diffusion parameters for bioturbation, and sedimentation-resuspension parameters. Mean annual wind speed should be entered. If values greater than zero are entered for the two enhanced diffusion parameters, mixing between the mixed layer and the top of the deep sediments is increased. Two of the three parameters of sediment resuspension, burial, and settling velocity must be entered, and the third parameter is computed from a steady-state solids mass balance. A zero should be entered for the value of the parameter to be estimated. After entering values for the other two parameters, the user should press the Recalculate button. If the calculated variable box is green with a dimmed value, then the values entered are reasonable and satisfy the solids mass balance. However, if the calculated variable box is red, then one or more of the entered parameters is too large or not large enough. Since only one parameter can be set to zero to establish the computed parameter, a very small number, such as 1E-20, can be entered to represent nearly zero for an entered parameter. Typically, the
Figure 57. Calculated Data screen of the RECOVERY model UI.

Figure 58. Model Parameters screen of the RECOVERY model UI.
burial and settling velocities are known, and the resuspension rate is 
computed, or the resuspension rate is set to a very small number along with 
a quantified settling velocity, and the burial velocity is computed. Of the 
three parameters, the sediment settling velocity is usually the best known.

The constituent properties screen (Figure 56) is used to enter the initial 
concentrations, additional external loadings, and properties of each MC. The 
set of inputs for each MC can be viewed by pressing either the “Next” or 
“Previous Compound” buttons at the top of the screen. There can be initial 
MC concentrations in the water, mixed layer, and deep sediment layers at the 
beginning of the simulation. Even a depth-varying profile of deep sediment 
initial MC concentrations can be entered by pressing the “Profile” button. 
However, for most TREECS™ applications, all initial concentrations will be 
set to zero, especially for explosives. There could be initial concentrations for 
metals due to background concentrations. The additional constant external 
loading is for a low-level, background loading of a constituent, such as one 
due to atmospheric deposition or some other removed loading source. This 
loading may also be set to zero in many TREECS™ applications.

The properties shown within the middle panel of Figure 56 are automati-
cally transferred from the constituent database if values exist within the 
database or if values were entered on the TREECS™ Site Conditions/
Constituent Selection screen. The user can override database values by 
entering a value directly on the constituent properties screen of TREECS™. 
The user can also override property values by entering the value directly in 
the property field of the RECOVERY Properties screen. If the “View 
Calculated Data” button is pressed, the screen shown in Figure 57 will be 
launched. This screen is used to view computed parameters, including 
partition coefficients for water column, mixed sediment, and deep sedi-
ment. It should be noted that the computed parameters are dimmed and 
cannot be changed. The equations used to compute each of these para-
meters are present in the RECOVERY model documentation (http://el.erdc.
usace.army.mil/elpubs/pdf/trel01-3.pdf). For inorganic MC (i.e., $K_{ow} = 0$), the partition 
coefficient parameter boxes are green and entries are not dimmed out; thus, 
the user can and should enter values for the partition coefficients. There is 
no generalized tool in RECOVERY for estimating these $K_d$ values for 
inorganic MC for surface water/sediments.

The bottom panel of the constituent properties screen (Figure 56) is used 
for entering decay (degradation) rates for dissolved and particulate
constituent in water, mixed layer, and deep sediments. There is little to no information in the constituent database for these inputs; thus, the user must enter the values. An entry of zero for each produces the most conservative results (i.e., highest concentrations).

The final input screen for RECOVERY is for model parameters (Figure 58). Usually, the user only needs to be concerned with the first parameter: the total period of simulation. This value may require adjustment for Tier 2 applications. Default values are automatically entered for the other parameters that are used to adjust model output intervals.

Like the other models, the RECOVERY model also has the capability to enter and track references for data entries. Each screen has a Reference button that can be pressed to enter a reference. (The mouse cursor must first be placed in a data field before pressing the reference button.)

CMS

The input screens of the CMS UI are shown in Figure 59 through Figure 63. The CMS UI has a help file for assistance in using the UI that can be accessed by pressing the “Help” button on the menu bar. Like the other models in TREECS™, CMS also has the capability to enter and track references for input values. For more detailed information regarding how the model works and the equations solved, the user should refer to the model documentation (http://el.erdc.usace.army.mil/elpubs/pdf/eltr07-1.pdf and http://el.erdc.usace.army.mil/elpubs/pdf/eltr07-1errata.pdf).

Under “File” on the menu bar there is an “Import” option. This was implemented to allow users to bring in a CMS input file created with the model UI applied in stand-alone mode outside of TREECS™. When the import function is used, only the model parameters, hydraulic parameters, and sedimentation parameters are imported. The constituent parameters and the loading data are passed from TREECS™.

The Model Parameters screen (Figure 59) is used to enter physical descriptions for the application, such as model time step, length of the simulation, stream and sediment attributes. Each input is described in the reports by Dortch et al. (2011a and 2011b) and the help file. The user has the option of entering either the number of computational segments or the length of each computational segment. Whichever input is selected, the other is computed based on the total length of the stream reach being
simulated. The stream longitudinal transport dispersion coefficient is entered on this screen along with the TSS concentration at the point of entry (the headwater). This model simulates only one benthic sediment layer, referred to as the Active Sediment Layer. The attributes of this layer are entered on the Model Parameters screen; the ambient temperature and the wind speed are also entered on this screen. The user can select the input units for dimensional input parameters.

Figure 59. Model Parameters screen of the CMS UI.

The usage location is shown in the first box at the top of the “Hydraulic Parameters” screen (Figure 60). Only one usage location is allowed in TREECS™. This location should be the point of interest for receptor exposure. The distance to the usage location from the point of entry is entered. This is the same thing as the distance from the point of entry of the loading from the AOI to the downstream receptor location and is also the total length of the stream reach being simulated. The point of entry
could be adjacent to the AOI if the stream starts there, or it may be removed from the AOI if overland flow carries MC from the AOI to the stream. There is no constituent degradation or attenuation for transport between the AOI and the point of entry.

![Hydraulic Parameters screen of the CMS UI.](image)

Stream geometrical data and flow rate are entered on the Hydraulic Parameters screen. There are basically two options for entering geometry: enter constant stream width and depth; or enter stream cross-sectional area, which can be constant or a function of flow rate. If a function of flow is selected, the user must enter four coefficient parameters that are used in the two equations shown on the screen for the stream cross-sectional area and stream depth. The stream flow at the point of entry must also be entered. This flow rate is constant over time, such as an average annual background flow, and should not include the AOI runoff flow rate passed from the soil model in the WFF.
Figure 61. Constituent Properties screen of the CMS UI.

Initial concentrations, constituent decay (degradation) rates, constituent properties, and constituent-dependent fate parameters, such as volatilization rate, are entered on the Constituent Parameters screen (Figure 61). It is noted that this screen must be filled out for each MC. The combo box at the top of the screen is used to select MC.

The background stream concentration for each constituent at the point of entry can be added, although this may be zero in many TREECS™ applications. This input concentration is constant over time and should represent the background concentration prior to any loading from the AOI. Background concentrations may be appropriate for some MC, such as metals. The initial concentration for the sediment bed at the beginning of the simulation can be entered, although this may be zero for many TREECS™ applications. The dissolved and particulate phase degradation rates for the water column and bed can be entered, but zero default values are preset for conservatism.
The user can enter the octanol-water partition coefficient $K_{ow}$ and can have the UI automatically compute the $K_d$, or the user can enter the $K_d$ for the water column and sediment bed directly. CMS uses the same equation as used in RECOVERY for computing $K_d$ based on $K_{ow}$. There is also the option of either entering the volatilization rate and bed-water column dissolved mass transfer velocity directly or having the UI calculate these parameters based on other entered data. The three constituent chemical properties are automatically transferred from the constituent database or from values entered on the “Site Conditions/Constituent Selection” screen of TREECS™. The user can override these values by entering a property value directly on the CMS screen, and this value will be used in any future application of the .trp case.
The inputs for the “Sedimentation Parameters” screen (Figure 62) are very similar to those in the RECOVERY model. The user must enter two of the three rate parameters, and the UI calculates the third from a steady-state solids mass balance. The value to be calculated should be set to zero. A very small number should be entered for a parameter that is essentially zero. Care must be exercised to ensure that entered parameters are not too large or small causing the calculation to fail, which is denoted by red font for the calculated rate.

The data shown on the “Loading Data” screen (Figure 63) are automatically transferred by TREECS™ based on output from upstream models (i.e., soil and groundwater), and no entries are required or allowed by the user. The data are merely displayed for the user to see what was transferred to the model.
There are two options under the “Options” button on the menu bar of the CMS UI: “Default Numerical Solution Settings” and “Project Numerical Solution Settings.” The first option is for setting the default numerical solution parameters for all projects. The second option is for setting the numerical solution parameters for only the project that is presently open. The same list of numerical solution parameters is required for either option, and the UIs for setting them are identical.

The numerical solution parameter UI is shown in Figure 64. There are two options for the time step method used in the time integration of the differential equation of sediment-bed constituent mass: constant time step or adaptive time step. When the adaptive method is checked, the size of the time step is automatically computed by the model to maximize the time step size while maintaining numerical stability. If adaptive is not checked, then the time step entered in the model UI will be used and held constant, and there is a risk that the user-specified time step size could result in numerical instabilities that produce erroneous results. There are also two choices for the method of solving the ordinary differential equation for sediment-bed constituent mass: first-order Euler time integration and fourth-order Runge-Kutta time integration. If “Use Runga-Kutta scheme” is not checked, then the first-order Euler time integration is used, which is less accurate than the Runga-Kutta scheme.

![Default Numerical Solution Settings](image)

Figure 64. Default Numerical Settings screen of the Options button on the menu of the CMS UI.
The CMS uses a Crank-Nicolson solution scheme for the partial differential equation of constituent mass transport/fate in surface water. This scheme is a mix of explicit and implicit operators with respect to time. The user can vary the coefficient or weighting between the implicit and explicit operators for advection and diffusion. A coefficient of 1.0 is fully implicit in time and uses only values at the end of the time step. A coefficient of 0.0 is fully explicit in time and uses only values at the beginning of the time step. The default is 0.55. The user can also choose between a central difference and upwind difference for the differencing scheme of the advective transport term. The central difference is the standard method of the Crank-Nicolson solution and is more accurate than upwind, but result in oscillations around sharp concentration gradients. The upwind scheme is less accurate and is numerically diffusive, thus dampening any oscillations. Only a steady-state solids balance is allowed within TREECS™; thus, this option for steady-state or time-varying solids balance is dimmed out.
5 Using Viewers

After the user has completed running a media model (i.e. soil, vadose, groundwater, or surface water) and completed running the S/U model (if applicable), then the appropriate viewers associated with the media will be enabled on the “View Results” tab of TREECS™. Each of these viewers is described below.

Tier I Tables

There is only one viewer, “Tier 1 Soil Mass Fluxes Table View,” available for this viewer type and it is only applicable for a Tier 1 analysis. This viewer is described below.

Tier 1 Soil Mass Fluxes Table View

The Tier 1 Soil Mass Fluxes Table View viewer is only applicable to a Tier 1 analysis. This viewer uses Crystal Reports to develop the tabular output report. The tabular output report shows the leaching, erosion, and runoff mass fluxes, as well as the sum of erosion and runoff mass fluxes for each constituent in the Tier 1 soil model output. An example of this viewer is shown in Figure 65 below.

Soil

There are several viewers available for this viewer type and each is described below.

Concentration Graphical View

The “Concentration Graphical View” viewer is applicable for Tier 1 and Tier 2 analyses. When this viewer is selected, a form like that shown in Figure 66 is shown.

The “Browse for benchmarks file” is currently not applicable since there are no soil benchmarks in the health benchmarks database. However, the user can still select the scenario benchmarks file if so desired, but there will not be any benchmarks plotted on any resulting chart that the user may create. The health benchmark file for a given scenario is automatically created for the user by the system and is generally of the form “<scenario>_HealthBenchmarks.xml”. An example of the “Browse for benchmarks file” dialog box is shown in Figure 67.
The “Number of charts (max 25)” combobox is used to select the number of charts that the user wishes to create for the current scenario dataset. In general, there are total and dissolved soil concentrations available for each constituent in the user’s scenario. The “Dataset” combo box is used to select between total and dissolved. The “Constituent” combo box is used to select constituents. An example of this form with two charts selected is shown in Figure 68. Note that when selecting options in the viewer it is recommended that the user select options from top to bottom. This is because the viewer repopulates all fields that appear after it once a selection has been made in an upper item.

Once the user has selected the desired information to chart, print, or save, then the user can click the corresponding Chart, Print, or Save menu located at the top of the form. This will chart the selection in MS Excel, send the current information to the default printer, or open a file save dialog box that will allow the user to select the name of the output text file, respectively. If the user clicks the “Chart” menu, then MS Excel will be launched and the
Figure 66. An example of the Soil concentration graphical viewer.

Figure 67. An example of the viewer browse for benchmark file dialog box.
worksheet will be populated with the information for the chart as well as the actual chart of the soil concentration versus time. An example of the plotted MS Excel chart is shown in Figure 69.

Additional help for the viewer can be found by clicking the “Help” menu on the form. To close the viewer, click the red X located at the top right of the form.

**Concentration Probability of Exceedance**

The “Concentration Probability of Exceedance” viewer is applicable for only a Tier 2 analysis. When this viewer is selected, a form like that shown in Figure 70 is displayed.

This form shows soil concentrations and corresponding probability of exceedance values for each concentration. The exceedance probabilities are determined from model results where concentration varies with time; thus, they are based on time frequency analysis. The user can select up to 25
different charts to be displayed in separate worksheets by selecting the desired number in the “Number of charts (max 25)” combobox. The user can change the number of exceedance intervals by clicking the up or down arrows in the “Number of exceedance intervals” combobox. The minimum number is 10 and the maximum number is 100. The user can choose to eliminate non-zero concentrations from the chart by selecting the “Use non-zero values only” checkbox, which will eliminate any soil concentrations of zero from the frequency analysis. The user can also show *Kolmogorov-Smirnov (K-S) goodness-of-fit* (Hogg and Tanis 1977) confidence intervals (see [http://mepas.pnl.gov/FramesV1/documents/PNNL13395-weap_update.pdf](http://mepas.pnl.gov/FramesV1/documents/PNNL13395-weap_update.pdf)) in a chart by selecting the “Use Kolmogorov-Smirnov Goodness-of-fit confidence intervals” checkbox. The Kolmogorov-Smirnov goodness of fit test a nonparametric test that can be used to set confidence limits for the shape of the distribution function; thus, it can be used to define confidence bands surrounding the exceedance probabilities. The K-S test determines confidence bands for unknown distribution functions. To create a MS Excel chart of the currently selected information, click the “Chart” menu. An example of this viewer with K-S goodness-of-fit is shown in Figure 69.

![Figure 69](image.png)

Figure 69. An example of MS Excel plot created for the soil graphical viewer.
Figure 70. An example of the Soil concentration probability
event intervals is shown in Figure 71. To print the information to the default
printer, select the “Print” menu. To save the current information to a text
file, click the “Save” menu. For additional help for the viewer, click the
“Help” menu. To close the viewer, click the red X located at the top right of
the form.

**Mass Flux Graphical View**

The “Mass Flux Graphical View” viewer is applicable for Tier 1 and Tier 2
analyses. When this viewer is selected, a form like that shown in Figure 72
is displayed.

Functionality is like that of similar viewers previously discussed. The user
can select the number of charts, the dataset, constituent, and flux type and
then chart, print or save. In general, what this viewer shows is the consis-
tuent mass flux for a particular flux type and given media path. Depending
on applicability to the user’s scenario, the soil model can produce consis-
tuent flux from the soil media into the vadose zone as well as into surface
water. These constituent flux correspond to “vadose to vadose zone...” and
“surface water to plus_operator...” (or surface water to surface water...), respectively, and subsequently show up as available dataset options in the viewer. If the user has not selected the surface water media, then the “surface water...” datasets may not be listed. The flux type is “total” for vadose to vadose and “adsorbed” or “dissolved” for either of the “surface water to...” datasets. An example of the chart from this type of report is shown in Figure 73.

Mass Flux Probability of Exceedance

The Mass Flux Probability of Exceedance viewer is applicable for only a Tier 2 analysis. This viewer allows the user to select the desired dataset, typically “vadose to vadose_zone,” “surface water to surface water,” or “surface water to plus_operators,” the desired constituent, and the flux type. If the user has not selected the surface water media, then the “surface water...” datasets may not be listed. The flux type is “total” for vadose to
vadose and “adsorbed” or “dissolved” for either of the “surface water to...” datasets. Again, the user can choose up to 25 charts to plot at a time. The user can also select to eliminate all zero values from the viewer statistics. Additionally, the user can select to use the K-S Goodness-of-Fit confidence intervals as well as the number of exceedance intervals. An example of the viewer is shown in Figure 74.

**TREECS™ Tier 2 Soil OUT Text Viewer**

The TREECS™ Tier 2 Soil OUT Text Viewer viewer is applicable for only a Tier 2 analysis. This viewer shows the tabulated raw output of the Tier II soil model at each time step for each constituent. It shows particle diameter, solid-phase mass, non-solid phase mass, constituent total concentration, etc., as well as various fluxes at each model time step. This viewer is primarily intended for advanced users. An example of this viewer is shown in Figure 75.
Figure 73. An example of the chart plotted when using the mass flux graphical viewer for soil.

Figure 74. An example of the mass flux probability of exceedance viewer for soil.
There are no viewers available for this viewer type for a Tier 1 analysis since the vadose zone model is not used in Tier 1. However, there are two viewers available for this viewer type for a Tier 2 analysis provided the user's scenario includes the groundwater receiving media. If the user's scenario does not include the groundwater receiving media, then no viewers are applicable and therefore none will be listed. Each of the available viewers is described below.

**Mass Flux Graphical View**

The “Mass Flux Graphical View” viewer is only applicable for a Tier 2 analysis. When this viewer is selected, a form like that shown in Figure 76 is displayed.

Functionality is like that of similar viewers previously discussed. The user can select the number of charts, the dataset, constituent, and flux type and then chart, print or save. For this viewer, the only dataset available for selection is “Vadose to all” and the only applicable flux type is “Total.”

**Mass Flux Probability of Exceedance**

The “Mass Flux Probability of Exceedance” viewer is only applicable for a Tier 2 analysis. This viewer is similar to that previously discussed for the soil mass flux probability of exceedance viewer. However, there is only one available dataset, i.e., “Vadose to all,” and one flux type, i.e., “Total.” An example of this viewer is shown in Figure 77.
Surface Water and Sediment

If the user's scenario does not include the surface water receiving media, then no viewers are applicable and therefore none will be listed. However, if the user's scenario does include the surface water receiving media, then there are several viewers available for this viewer type and each is described below.

Sediment Concentration Graphical View

The “Sediment Concentration Graphical View” viewer is applicable for Tier 1 and Tier 2 analyses. When this viewer is selected, a form like that in Figure 78 is shown.
The user can utilize the “Browse for benchmarks file” to browse for the scenario health benchmarks file. This file is automatically created for the user by the TREECS™ application and is of the form “<project>_Health Benchmarks.xml” and located in the same directory as the user’s project file. There are total and dissolved sediment concentrations available for each constituent in the user’s scenario from which to select for the desired dataset. These are typically, “Sediment-Total to Exposure_Pathways...” and “Sediment-Dissolved to Exposure_Pathways...,” which are for total and dissolved concentrations, respectively. All other viewer functionality is like that previously discussed for the soil concentration graphical viewer.
Figure 78. An example of the Sediment concentration graphical viewer.

**Sediment Concentration Probability of Exceedance**

The “Sediment Concentration Probability of Exceedance” viewer is applicable only for a Tier 2 analysis. This viewer is similar to that previously discussed for the soil mass flux probability of exceedance viewer. However, the available datasets are “Sediment-Total to Exposure_Pathways...” and “Sediment-Dissolved to Exposure_Pathways...” An example of this viewer is shown in Figure 79.

**Surface Water Concentration Graphical View**

The “Surface Water Concentration Graphical View” viewer is applicable for Tier 1 and Tier 2 analyses. This viewer is similar to that previously discussed for the sediment and soil concentration graphical viewers. However, the available datasets are “Surface Water-Total To Exposure_Pathways...” and “Surface Water-Dissolved to Exposure_Pathways...” The user should select the corresponding health benchmark file prior to plotting any charts. An example of this viewer is shown in Figure 80.
Surface Water Concentration Probability of Exceedance

The “Surface Water Concentration Probability of Exceedance” viewer is applicable only for a Tier 2 analysis. This viewer is similar to that previously discussed for the soil and sediment concentration probability of exceedance viewer. However, the available datasets are “Surface Water-Total to Exposure_Pathways...” and “Surface Water-Dissolved to Exposure_Pathways...” An example of this viewer is shown in Figure 81.

Surface Water Mass Flux Graphical View

The “Surface Water Mass Flux Graphical View” viewer is applicable only for a Tier 2 analysis. When this viewer is selected, a form like that shown in Figure 82 is displayed.
Functionality is like that of similar viewers previously discussed. The user can select the number of charts, the dataset, constituent, and flux type and then chart, print or save. For this viewer, the only dataset available for selection is “Surface Water to all” and the available flux types are “Adsorbed” and “Dissolved.”

**Surface Water Mass Flux Probability of Exceedance**

The “Surface Water Mass Flux Probability of Exceedance” viewer is applicable only for a Tier 2 analysis. This viewer is similar to that previously discussed for the soil mass flux probability of exceedance viewer. However, the only available dataset is “Surface Water to all” and the available flux types are “Adsorbed” and “Dissolved.” An example of this viewer is shown in Figure 83.
RECOVERY Viewer

The RECOVERY Viewer is applicable only for a Tier 2 analysis and only if the surface water model chosen (i.e., using Options → Project → Model → Selection) for the scenario was the RECOVERY surface water model. An example of this viewer is shown in Figure 84.

The user can select the type of plot from the topmost combobox, which includes “Contaminant Concentration in Water,” “Contaminant Concentration in Mixed Layer,” “Dissolved Contaminant Conc. in Mixed Layer Pore Water,” “Flux of Contaminant from Sediments in Water,” “Volatilization Rate from the Water,” “Theoretical Bioaccumulation Potential” and “Animate Deep Sediment Contaminant Concentration Profile.” The option for plotting the theoretical bioaccumulation potential is not activated for TREECS™. The user can also select the desired constituent for the desired plot from the combobox beneath the topmost combobox. After selecting the
desired plot type and the constituent, the user can click the “View Plot” button to display the selections. An example of the “Contaminant Concentration in Water” plot is shown in Figure 85. With the exception of the “Animate Deep Sediment Contaminant Concentration Profile,” all of the other viewers operate and display similarly. The “Animate Deep Sediment Contaminant Concentration Profile” viewer will display a dialog box like that shown in Figure 86 when selected. This dialog box requires that the user select the desired animation option based upon concentration types, which include: mass of contaminant per mass of sediment (mg/kg); mass of contaminant per volume of sediment (µg/m³); mass of contaminant per volume of sediment (mg/L); or mass of dissolved contaminant per volume of pore water (mg/L). An example of the “mass of contaminant per mass of sediment” option is shown in Figure 87. Once the user makes the appropriate selection, he/she can click the “Run Animation” button to animate the concentration profile over the simulated time period. It is noted that the sediment concentration versus depth profile for this viewer is inverted. Thus, zero depth is located at the interface between the deep sediment and the surficial mixed sediment layer, and sediment depth moves downward into the bed for increasing depths on the vertical axis of the plot.
Figure 83. An example of the mass flux probability of exceedance viewer for surface water.

Figure 84. The Recovery Viewer main dialog box.
Contaminant Model for Streams (CMS) Viewer

The “Contaminant Model for Streams (CMS) Viewer” is applicable only for a Tier 2 analysis and only if the surface water model chosen (i.e., using Options → Project → Model Selection) for the scenario was the Contaminant Model for Streams (CMS). An example of this viewer is shown in Figure 88.
Figure 87. The Recovery viewer for animating deep sediment concentration profile.

Figure 88. The Contaminant Model for Streams (CMS) Viewer main dialog box.
The user can select the results type (i.e., graphical or text), media type (i.e., water or sediment), constituent (or suspended solids), specify the title for the chart, select the x-axis (i.e., distance or time), y-axis (i.e., concentration), y-axis units (e.g., mg/L), total/dissolved concentration (i.e., total or dissolved), select the times (for distance on the X-axis) or distance (for time on the X-axis) for the output, specify the graph X dimension (in pixels), and specify the graph Y dimension (in pixels). An example of the plot is shown in Figure 89 for water column total concentration versus distance along the stream at a given time. By checking the “Animate All” box, the user can also choose to animate for all times the plots of concentration versus distance or animate for all distances the plots of concentration versus time.

![Figure 89. An example plot of the Contaminant Model for Streams (CMS) Viewer.](image)

**Groundwater**

If the user's scenario does not include the groundwater receiving media, then no viewers are applicable and therefore none will be listed. However, if the user's scenario does include the groundwater receiving media, then there are several viewers available for this viewer type and each is described below.
Concentration Graphical View

The “Concentration Graphical View” viewer is applicable for Tier 1 and Tier 2 analyses. This viewer is similar to those previously discussed for the other concentration graphical viewers. However, the available datasets are “Aquifer-Dissolved to Well_#,” where well # refers to the well number. Depending on the user's scenario, there can be up to five wells for a Tier II analysis or only one well for a Tier I analysis. The user should select the corresponding health benchmark file prior to plotting any charts. An example of this viewer is shown in Figure 90.

![Figure 90. An example of the Groundwater concentration graphical viewer.](image-url)
Concentration Probability of Exceedance

The “Concentration Probability of Exceedance” viewer is applicable only for a Tier 2 analysis. This viewer is similar to that previously discussed for the other concentration probability of exceedance viewers. However, the available datasets are “Aquifer-Dissolved to Well_#” where # can range from one to five, depending on the number of wells that the user selected for the given scenario. An example of this viewer is shown in Figure 91.

![Concentration Probability of Exceedance Viewer](image)

Figure 91. An example of the concentration probability of exceedance viewer for groundwater.

Mass Flux Graphical View

The “Mass Flux Graphical View” viewer is applicable only for a Tier 2 analysis. When this viewer is selected, a form like that shown in Figure 92 is displayed.
Figure 92. An example of the mass flux graphical viewer for groundwater.

Functionality is like that of similar viewers previously discussed. The user can select the number of charts, the dataset, constituent, and flux type and then chart, print or save. For this viewer, the only dataset available for selection is “Aquifer to Plus_Operators” or “Aquifer to all” and the only available flux type is “Total.” The “Aquifer to Plus_Operators” dataset is listed if the user’s modeling scenario includes both surface water and groundwater and is the flux from groundwater to a surface water body. The “Aquifer to all” dataset is listed when the user’s modeling scenario contains groundwater and no surface water and is the groundwater flux to a well location.

**Mass Flux Probability of Exceedance**

The “Mass Flux Probability of Exceedance” viewer is applicable only for a Tier 2 analysis. This viewer is similar to that previously discussed for the soil mass flux probability of exceedance viewer. However, the only available dataset is “Aquifer to Plus_Operators...” or “Aquifer to all” and the only available flux type is “Total.” An example of this viewer is shown in Figure 93.
Figure 93. An example of the mass flux probability of exceedance viewer for groundwater.

**Sensitivity/Uncertainty**

This viewer type is only applicable to Tier 2 analyses. If the scenario has not specified any uncertain parameters, nor run the S/U model on the Uncertainty tab of TREECS™, then no viewers will be available for selection. However, if the S/U model has been run, then there are several viewers available for this viewer type and each is described below.

**Cumulative Distribution Function Viewer**

The “Cumulative Distribution Function Viewer” is applicable for only a Tier 2 analysis. When the user selects this viewer, a command window will open and some processing will be performed using the “R 2.3.1” statistical software that is installed with TREECS™. Once processing has completed, a portable network graphics (PNG) image file will be displayed by the Windows Picture and Fax Viewer. The image will contain one or more
cumulative distribution function (CDF) plots for the S/U input variables that the user selected as being uncertain in the “Specify Uncertain Parameters” area on the Uncertainty tab of TREECS™. An example is shown in Figure 94.

A CDF describes the probability that a real-valued random variable \( X \) with a given probability distribution will be found at a value less than or equal to \( X \). With regard to the viewer, it plots CDFs of values, allowing the user to find a given input or output value for a given percentile. The line shown in the plot represents the 95\(^{th} \) percentile. Additional information can be found in Castleton et al. 2006 (or here: [http://www.pnl.gov/main/publications/external/technical_reports/PNNL-16781.pdf](http://www.pnl.gov/main/publications/external/technical_reports/PNNL-16781.pdf))

**Histogram Viewer**

The “Histogram Viewer” is applicable for only a Tier 2 analysis. When the user selects this viewer, a command window will open and some processing will be performed using the “R 2.3.1” statistical software that is installed with TREECS™. Once processing has completed, a portable network
graphics (PNG) image file will be displayed by the Windows Picture and Fax Viewer. The image will contain one or more histograms for the S/U input variables that the user selected as being uncertain in the “Specify Uncertain Parameters” area on the Uncertainty tab of TREECS™. An example is shown in Figure 95.

![Histogram Viewer Example](image)

**Figure 95. An example of the histogram viewer for sensitivity/uncertainty.**

A histogram provides the frequency of occurrence versus all independent and dependent variables chosen by the user in the statistical analysis. See [http://www.pnl.gov/main/publications/external/technical_reports/PNNL-16781.pdf](http://www.pnl.gov/main/publications/external/technical_reports/PNNL-16781.pdf) for additional information.

**Partial R Viewer**

The “Partial R Viewer” viewer is applicable for only a Tier 2 analysis. When the user selects this viewer, a command window will open and some processing will be performed using the “R 2.3.1” statistical software that is installed with TREECS™. Once processing has completed, a portable network graphics (PNG) image file will be displayed by the Windows Picture and Fax Viewer and MS Notepad will be opened with an associated text file.
for the text generated during the process. The image will contain a scatter plot that graphs all input variables against all other input variables and all output variables (i.e., provided in the “Specify Uncertain Parameters” area on the Uncertainty tab). The scatter plot is an optimized regression analysis that uses R’s linear model and stepwise capability. The analysis is performed once for each output variable in the output dataset. An example is shown in Figure 96. In this figure, "RDXdia" is the particle diameter for the constituent RDX that was treated as uncertain with a log-normal distribution and "RdxFPk_vad5_Vadose_" and "RdxFPk_vad5_Vadose_.1" are the monitored output peak mass fluxes of constituent RDX into the vadose zone for two different S/U iterations. The values for "RDXdia" are shown at the top right and bottom left of the figure and have a unit of "um." The RDX peak mass flux values for "RdxFPk_vad5_Vadose_" are shown in the top middle and left middle of the figure and have a unit of “g/yr.” The RDX peak mass flux values for “RdxFPk_vad5_Vadose_.1” are shown in the bottom right horizontal and vertical directions and have a unit of “g/yr.” Note that the more S/U parameters and iterations in an analysis, the more difficult it is to read the scatter plot.

![Figure 96. An example of the Partial R viewer for sensitivity/uncertainty.](image)

The text file will provide a lot of additional information for the user, including an indication of the sensitivity of the output to variation of the
input parameters (i.e. significance). Asterisks are used to indicate the degree of significance. The more asterisks displayed beside a parameter, the more sensitive the output was to changes in that parameter. See [http://www.pnl.gov/main/publications/external/technical_reports/PNNL-16781.pdf](http://www.pnl.gov/main/publications/external/technical_reports/PNNL-16781.pdf) for additional information. The contribution to the variance in output is also indicated for each uncertain input. An example of the textual output is shown in Figure 97.

![Image](image.png)

**Figure 97.** An example of the textual output of the Partial R viewer for sensitivity/uncertainty.

**Cumulative Probability**

The “Cumulative Probability” viewer is applicable for only a Tier 2 analysis. This viewer displays a plot of sampled input and realization output values from each Monte Carlo simulation versus the cumulative probability (or the probability of not being exceeded). This viewer is the opposite of the probability of exceedance viewer; i.e., probability of exceedance = 1 – cumulative probability. An example of this viewer is shown in Figure 98.

**Probability of Exceedance**

The “Probability of Exceedance” viewer is applicable for only a Tier 2 analysis. This viewer shows the probability of exceeding a value over the range of values considered. An example of this viewer is shown in Figure 99.
Figure 98. An example of the Cumulative Probability viewer for sensitivity/uncertainty.

Figure 99. An example of the Probability of Exceedance viewer for sensitivity/uncertainty.
Sample Variable vs. Time with Confidence Bands

The “Sample Variable vs. Time with Confidence Bands” viewer is applicable for only a Tier 2 analysis. When the user selects this viewer, a dialog box like that shown in Figure 100 will be displayed. The actual available options may be different depending on the user’s scenario. The user should select the “Soil Model SU Confidence Interval,” “Groundwater Model SU Confidence Interval,” “Surface Water Model SU Confidence Interval for Sediment,” or “Surface Water Model SU Confidence Interval,” if interested in the soil, groundwater, sediment, or surface water media, respectively.

![Select the desired viewer](image)

Figure 100. The Sample Variable vs. Time with Confidence Bands viewer dialog box for sensitivity/uncertainty.

An example of the “Surface Water Model SU Confidence Interval” option’s dialog box is shown in Figure 101. The user should select the benchmark file for the project, select whether to eliminate zero values, select the desired first and second bounds (the default is 5 and 95, respectively), the number of exceedance intervals (the default is 10), and the number of charts to display. Close attention should be given to options to select for Dataset and Constituents to plot. These functions are like those explained before. For surface water, the dataset options are total and dissolved concentrations, and lead is the constituent selected for this example. The number of exceedance intervals is used to refine the interpolation of the confidence bounds. When the user clicks the “Chart” menu, MS Excel will display a chart like that shown in Figure 102 where the model output is bounded by the first and second bounds that were selected.
Figure 101. The Surface Water Model SU Confidence Interval option for sensitivity/uncertainty.

Figure 102. An example of the resulting chart from the Surface Water Model SU Confidence Interval option for sensitivity/uncertainty.
6 Conducting Sensitivity and Uncertainty

In order to conduct sensitivity/uncertainty (S/U) analysis, the user must be conducting a Tier 2 analysis. S/U is not applicable to Tier 1 analyses. The Uncertainty tab of TREECS™ is where the user conducts an S/U analysis. In order to begin S/U, the user should first have completed all model input for the media models and should also have run each of those models. The system enforces this by disabling the appropriate buttons on the Uncertainty tab if the required model input and run prerequisites have not been met. Once these have been completed, then the user is ready to begin an S/U analysis of the current scenario. Each of the “Specify Uncertain Parameters” and “Run S/U model” button options available on this tab is discussed below.

Specify Uncertain Parameters

The user can click the Specify Uncertain Parameters button. This will bring up a dialog box like that shown in Figure 103 below. The user should select all of the constituents that he/she wishes to evaluate in the S/U analysis. After making the constituent selection and clicking the “Continue” button, a dialog box similar to that shown in Figure 104 will be displayed.

![Figure 103. Example of the initial dialog box displayed when the Specify Uncertain Parameters button has been clicked.](image-url)
This dialog box is the main input form for specifying which parameters to treat as uncertain. The dialog box contains a tree view in the left panel. As the user selects a parent, leaf, or child node in the tree view, the right side panel populates with information specific to that parent, leaf, or child node. There are three main nodes in the tree view, “Alias Input Variables,” “Alias Output Watches,” and “Distributions/Correlations.” The “Alias Input Variables” and “Alias Output Watches” nodes each contain child nodes associated with each media in the user’s scenario. As the user selects nodes in the left tree view, the right panel will update accordingly. If the user clicks a main node, then the right panel will display all information associated with that main node as well as all child and sub-child nodes. If the user clicks a parent node, then the right panel will display information for the parent and any child nodes. If the user clicks a child node, then the right panel will only display information related to that child. Each of the main nodes is described below.

**Alias Input Variables**

The “Alias Input Variables” node contains child nodes for each media in the user’s scenario (e.g., Source (i.e., Soil), Surface_Water, Aquifer (i.e., Groundwater), and Vadose_Zone). These child nodes also contain identifiers for each of these media (e.g., (src2), (riv5), etc.). These are internal identifiers and can therefore be disregarded by the user. Each of these child...
nodes additionally contains a sub-child node for each constituent (e.g., tnt) that the user selected in the initial dialog box in Figure 103. The Aquifer child node additionally contains a sub-child node for each well location in the user’s scenario (i.e., exp7). However, the well is not clearly identified as such, but instead has the form exp# which represents the internal name for the well location and where # is an integer number.

When the user selects the desired node, then he/she should select the desired input parameter that he/she wishes to treat as uncertain in the right panel. This is done by clicking on the desired parameter in the right panel listbox, then entering a descriptive short alias (currently limited to 9 characters) in the “Alias” textbox at the top of the right panel, and then clicking the “Add” button. The listbox will then update to show the user’s alias for the selected parameter. An alias can be deleted by first selecting the aliased parameter in the right panel list box and then clicking the “Delete” button at the top of the right panel. This will remove the aliased parameter. The user can use the “View aliased Inputs” checkbox at the top of the right panel to display only the existing aliased parameters in the listbox. Unchecking this checkbox will show all parameters whether aliased or not in the listbox.

If the user desires to reference a parameter alias, then that can be done by selecting the aliased parameter in the listbox and clicking the “References” menu at the top of the form. The user can then select the “Add” or “Select” menu item to either add a new reference or select from a list of previously supplied references.

**Alias Output Watches**

The “Alias Output Watches” node contains child nodes for each media in the user’s scenario (e.g., Source (i.e., Soil), Surface_Water, Aquifer (i.e., Groundwater), and Vadose_Zone). These child nodes also contain identifiers for each of these media (e.g., (src2), (riv5), etc.). These are internal identifiers and can therefore be disregarded by the user. Each of these child nodes additionally contains a sub-child node for each constituent (e.g., tnt) that the user selected in the initial dialog box in Figure 103. Figure 105 shows an example of this node.
The user should select the desired node and then select the desired output parameter(s) to watch or monitor. The user can typically monitor water flux peak, water flux average over some number of years, water flux at specified years, as well as similar options for total or dissolved constituent concentrations and mass fluxes. If the user chooses one of the watch options which involves monitoring at a given time, then after the user specifies an alias for the output parameter, a dialog box will appear for the user to specify the times as shown in Figure 106. To change times after initially entering them, the user can select the aliased parameter in the listbox and then click the “Edit Time” button at the top of the right panel. By monitoring output at specified years, the user will be able to determine uncertainty confidence bands for time varying output by using the “Sensitivity/Uncertainty” viewer entitled “Sample Variables vs. Time with Confidence Bands.” The other output monitoring options mentioned above are best suited to viewing as cumulative or exceedance probability plots.

**Distributions/Correlations**

The “Distributions/Correlations” node contains no child nodes. Figure 107, Figure 108, and Figure 109 show examples of this node along with the various tabs that it contains (i.e., Distribution, Correlations, and Equation), respectively.
Figure 106. Example of how times can be specified for aliased output watches in the S/U main form.

Figure 107. Example of the Distributions/Correlations node emphasizing the Distribution tab.
Figure 108. Example of the Distributions/Correlations node emphasizing the Correlations tab.

Figure 109. Example of the Distributions/Correlations node emphasizing the Equation tab.

The “Random seed value” defaults to 1, but the user can change the value to any desired integer number between 1 and 999,999. It is used by the S/U model to generate random sampling numbers. In order to reproduce
sampled value numbers from another scenario, the user should ensure that the random seed matches between the two scenarios.

The “Number of iterations” is the number of sampling runs that the user wishes to be performed by the S/U model. The maximum number is limited by the user’s physical memory. The minimum number is the number of input aliases specified by the user + 1.

The “Delay Run Until” checkbox is used to run the S/U model at a specific time. The associated time specified when using this option should be in military time and to the nearest hour. This feature may be useful for S/U runs that will take a long time, and it is more convenient for the user to start the run when the computer is not being used.

The “Distribution” tab is used to specify the distribution type of an input parameter alias along with the statistical information (e.g. upper bound, lower bound, mean, standard deviation, log base, etc.) associated with the selected distribution type for the variable selected. Supported distribution types include none, uniform, log uniform, normal, and log normal. Supported log base types include base 10 and base e (i.e., natural). The S/U module will use the user’s specified distribution when it samples for the input variable value to use for each S/U iteration. Care should be taken by the user to ensure that the selected distribution is actually appropriate for the aliased variable.

The standard deviation of a normal distribution can be estimated by taking the difference in the upper and lower bounds and dividing by 6.0. It is important to understand how the mean log and standard deviation log should be computed for log-normal distributions. The mean log is simply the log of the mean for the distribution of the variable of interest. The standard deviation log can be estimated by taking the difference in the log of the upper bound and log of the lower bound and dividing that difference by 6.0.

The “Correlations” tab is used to specify any correlations between two input variable aliases. This allows the user to preserve a relationship between related variables. The correlation parameter ranges between -1 and 1, where -1 indicates a strong negative correlation (i.e., one variable increases while the second decreases), and 1 indicates a strong positive correlation (i.e., one variable increases while the second increases). Correlations can be decimal
fractions, and a value of zero indicates no correlation. The correlation should be included by selecting the input alias in the “Alias” list box, selecting a corresponding input alias from the combo box in the “Correlations” panel, and then entering the correlation value in the input box under “Correlation” on the right side of the Correlations panel. The user then clicks the “Add” button to include the correlation, which will then show up in the list box under “Correlations.” Likewise, a correlation can be deleted by selecting the correlation in the “Correlations” list box and clicking the “Delete” button. Even if input variables are correlated, they must still have a distribution. The correlations feature came with the S/U package from Battelle Pacific Northwest Laboratory (PNNL). Users should be aware that this feature has not received much testing by ERDC, so it should be used with caution.

The “Equation” tab is used to relate two or more input variables as a function of those variables. The user can specify the equation in the “Enter an equation” textbox and click the “Add” button to add the equation. An existing equation can be deleted by selecting it and the clicking the “Delete” button. All independent variables will be sampled while the dependent variable will be calculated by the S/U module. An example could be the relationship between total porosity and bulk density (i.e., total porosity = 1.0 – (bulk density/2.65). Bulk density will be randomly sampled, and porosity will be computed from it throughout the Monte Carlo simulations. Thus, the distribution for porosity will not be used if one is entered for it. Care should be exercised when using this functionality to ensure that any equation specified is consistent with the units in any associated input variable alias’ distribution identified on the “Distribution” tab. The equation feature came with the S/U package from PNNL. Users should be aware that this feature has not received much testing by ERDC, so it should be used with caution.

Run S/U model

The user can click the “Run S/U model” button to run the model. The S/U model will randomly sample input variables following a Monte Carlo sampling procedure for correlated variables or a Latin Hypercube sampling procedure for uncorrelated variables. Once the user clicks this button, the S/U model will run for the specified number of iterations. During the course of S/U model execution, the user may see several command prompt windows appearing on and disappearing from the user’s screen. When these command prompt windows appear, they are the currently active window.
This is normal, but may affect the user’s ability to perform other work outside of TREECS™ temporarily until all of the iterations complete. Once complete, and if no errors were encountered, then the user should have numerous viewers available to view the results from the S/U run.

Depending on the details of the case being simulated, the number of constituents being simulated, the period of time for each simulation, and the number of Monte Carlo simulations (iterations), the computational time can be quite long. In these cases, it may be best to set a later start time ("Delay Run Until") as described previously. It is always good to make at least two S/U runs for a given uncertainty setup to ensure that enough iterations were run to accurately capture the uncertainty. For example, a run could be made with 500 iterations and output saved. Another run for the same inputs could be run for 1000 iterations and the output compared to the previous run of 500 iterations. If the results are close, then the number of iterations was set high enough in the 500-iteration run. If the results are substantially different, then another run should be made with the number of iterations increased. This process should be continued until the number of iterations does not affect the results substantially. Also, variations in the random seed should not affect output substantially if enough iterations have been performed.
References


Appendix A: Using GIS

General Functionality

There are several GIS-related tools built into TREECS™. These tools are accessed from the Installation/AOI Description tab (see Figure A1). The GIS functionality is broken down into three main areas, which are the functions and tools themselves, the GIS legend and the GIS workspace. These are shown in Figure A2. Note that in order to use this functionality the user must create a new project or open an existing project. This is because all tabs of TREECS™ are disabled until a project has been created or opened.

GIS Workspace

The GIS workspace is where GIS files are displayed. In general, all GIS files associated with an installation are loaded once an installation is selected for a project. However, the GIS workspace also works interactively with the “GIS Functions/Tools” and “GIS Legend” for some operations.
GIS Legend

The GIS legend shows all of the grid and shapefiles that the user currently has opened for a project. File groups (i.e., “Grids,” “Shapes”) as well as individual files (e.g. “<shapefile>.shp,” “<gridfile>.asc”) can be turned on or off by checking/unchcking the checkbox next to the corresponding group or individual file. Individual files are termed “layers” in GIS nomenclature. This will correspondingly turn on or off the corresponding layer displayed in the GIS workspace.

Layers can be moved up or down in the legend by left-clicking on a layer in the legend, holding down the left button of the mouse, and then dragging the layer up or down as desired. This will move the layer correspondingly in the workspace.

Individual layers can be removed, by right-clicking the mouse and selecting “Remove layer” from the pop-up menu that appears. An example of the pop-up menu is shown in Figure A3 for a grid layer. The system will prompt the user for confirmation of the selected layer’s removal. If the user confirms the removal, the layer will be removed from the legend and the workspace. It will not delete the actual file that corresponds to the selected layer.

The user can obtain information about a specific layer in the legend by right-clicking the mouse on a layer and then selecting “Grid Info” or “Shapefile Info” for the grid or shape, respectively. An example of the “Grid Info” dialog box that will then be displayed is shown in Figure A4.
On the “Grid Info” dialog box, the user can move the mouse around within the workspace and information will be displayed as to the location of the cursor (i.e., X and Y coordinates) as well as the grid cell value immediately underneath the mouse. The user can zoom in or out by using the corresponding magnifying glass with a plus symbol icon on the right of the dialog box and then moving the mouse to the workspace area and then left-clicking the mouse and, while holding down the left mouse button, dragging out a zoom box and then releasing the left mouse button. This will zoom the workspace to the area that the user selected. This process can be further repeated to zoom in even further. A similar process can be used by selecting the “magnifying glass with a minus symbol” icon on the right of the dialog box in order to zoom out. Alternatively, users with a scroll button on their mouse can click in the workspace and then scroll forward or backward to
zoom in or out, respectively. The user can also move the selected layer around in the workspace by using the “hand” icon on the right and then clicking inside the workspace and dragging the image around within the workspace.

An example of the “Shapefile Info” dialog box that will then be displayed for a polygon shapefile is shown in Figure A5. Note that the shape layer pop-up menu for a point shapefile contains only the “Remove layer” menu item. Neither the “Shapefile Info” nor the “Properties” pop-up menu items appear for a point shapefile layer.

![Shapefile Information](image)

Figure A5. An example of the Shapefile Info dialog box for a polygon shapefile layer

On the “Shapefile Info” dialog box, the user can zoom in and out as well as pan just like that described above for the “Grid Info” dialog box. Note that this dialog box is slightly different depending on whether the shapefile selected is a polygon or line. The one shown in Figure A5 is for a polygon shapefile. When compared to the “Grid Info” dialog box, the “Shapefile Info” dialog box has an additional data grid on the left of the dialog box as well as an absence of the X, Y location and grid cell value fields. The user can click any cell in the data grid and the workspace will automatically zoom to that item and highlight the item in magenta. Additionally, length for a line shapefile and area for a polygon shapefile, respectively, will be displayed under the data grid once an item in the data grid has been selected.
The user can change several properties for a given layer by right-clicking the layer in the legend and selecting “Properties” from the pop-up menu that is displayed. An example of the “Properties” dialog box for a grid layer is shown in Figure A6.

![Layer Properties dialog box](image)

Figure A6. An example of the Properties dialog box for a grid layer.

The user can change the grid coloring scheme, the transparency color, and turn on or off the display of the selected transparency color. To change the transparency color, click in the cell to the right of the “TransparencyColor” cell and select the new color to use for the transparency color. Selecting a color will cause the system to “hide” that color in the grid, provided that the user has the “UseTransparency” option set to “true.” Selecting the “GridColoringScheme” option will bring up an editor like that shown in Figure A7.

In the “Grid Color Scheme Editor,” the user can click in the “Low Color” or “High Color” cells to select the desired color from the pop-up color selector. Once the user selects a color, then he/she needs to specify the actual value that will be used as the cutoff for the low and high values. This is done by clicking in the “Low Value” or “High Value” cells and then entering the desired value. The user can add additional rows (using the “Add new row” button) and repeat this procedure until the desired color ramp has been achieved. New rows are added to the bottom in a new row of the data grid. Note that the user should make sure that the grid coloring scheme makes sense in that the high value on a previous row should correspond to that value plus, typically, 1.0 for the low value on the next row. In other words,
make certain that there is a smooth progression from one row’s low and high value to the values of the next row without overlap. To delete a row, when there are multiple rows, select the entire row in the data grid and then click the "Delete row" button to delete the selected row. The user can click the “Preview” button to preview the current grid coloring scheme in a new window. Click the “Cancel” button to exit the editor without making any changes. If the user clicks the “OK” button, then he/she will be prompted to add the revised grid coloring scheme to the main TREECS™ GIS legend and workspace. The editor does not change the existing grid’s coloring scheme, but instead, allows the user to essentially create a copy of that grid and specify a new grid coloring scheme for it. An example of this prompt is shown in Figure A8. After selecting the filename for the new grid file and clicking the “OK” button, the system will prompt the user for a short name for the new grid layer with the new grid coloring scheme as shown in Figure A9. After providing a short name for the grid with the revised color scheme, the main GIS workspace will display the new grid. An example of this is shown in Figure A10.

An example of the “Properties” dialog box for a polygon shape is shown in Figure A11.
Figure A8. An example of the grid color Scheme Editor’s prompt for a new grid filename.

Figure A9. An example of the Grid Color Scheme Editor’s prompt for a grid file short name.

Figure A10. An example of TREECS™ GIS workspace with the revised grid color scheme added.
On the “Properties” dialog box for a polygon shape, the user can select whether to turn on or off the filling of a polygon (using the “ShowFill” field), change the fill color (using the “FillColor” field) and outline color (using the “OutlineColor” field) as well as set the percent transparency (using “PercentTransparency” field) of the layer. The “FillColor” and “OutlineColor” fields allow the user to select a color from a pop-up color editor. The “ShowFill” value should be set to “true” to display the fill color for the shape or to “False” to not display the fill color for the shape. The ‘PercentTransparency” field should be between 0 and 100. Once the user clicks the red “X” in the top right corner of the dialog box, the box will close and the user’s changes will be reflected in the corresponding layer.

An example of the Properties dialog box for a line shapefile is shown in Figure A12. This dialog box only allows the user to change the color of the line (using the “LineColor” field). Clicking in the “LineColor” field will cause a color editor to pop-up that will allow the user to select the desired color for the line. Once the user clicks the red “X” in the top right corner of the dialog box, the box will close and the user’s changes will be reflected in the corresponding layer.

**GIS Functions/Tools**

This section describes the GIS functions/tools. Figure A13 shows the various functions/tools that are available. These are briefly described in Table A1. A complete description of the individual functions/tools is provided below.
Figure A12. An example of the Properties dialog box for a line shapefile layer.

Figure A13. TREECS™ GIS Functions/Tools.

Table A1. GIS Functions/Tools of TREECS™.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🗄️</td>
<td>GIS File open function</td>
<td>Used to open an individual GIS file</td>
</tr>
<tr>
<td>📁</td>
<td>GIS File save function</td>
<td>Used to save an individual GIS file that the user has created with the TREECS™ GIS tools</td>
</tr>
<tr>
<td>🡀</td>
<td>Resample grid tool</td>
<td>Used to resample a grid typically from one grid cell size to another</td>
</tr>
<tr>
<td>🕵️</td>
<td>Zoom in function</td>
<td>Used to zoom into an area in the GIS workspace</td>
</tr>
<tr>
<td>🕵️</td>
<td>Zoom out function</td>
<td>Used to zoom out of an area in the workspace</td>
</tr>
<tr>
<td>Icon</td>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>-------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>🕵️‍♂️</td>
<td>Pan function</td>
<td>Used to move layers around in the workspace</td>
</tr>
<tr>
<td>🕵️‍♂️</td>
<td>AOI by rectangle tool</td>
<td>Used to create an area of interest (AOI) by drawing a rectangle in the workspace</td>
</tr>
<tr>
<td>🕵️‍♂️</td>
<td>AOI by polygon tool</td>
<td>Used to create an AOI by drawing a polygon in the workspace</td>
</tr>
<tr>
<td>🟦</td>
<td>Measure tool</td>
<td>Used to measure length or area in the workspace</td>
</tr>
<tr>
<td>📷</td>
<td>Convert shapefile to grid tool</td>
<td>Used to convert a shapefile to a grid</td>
</tr>
<tr>
<td>🕵️‍♂️</td>
<td>Extract subset tool</td>
<td>Used to extract a new grid from an existing grid using an AOI shapefile as a “cookie cutter”</td>
</tr>
<tr>
<td>🕵️‍♂️</td>
<td>Map grid calculations tool</td>
<td>Used to create a slope grid and perform simple math operations (e.g. multiple, divide, add, subtract) on existing grids</td>
</tr>
</tbody>
</table>

**GIS File Open Function**

The purpose of this function is to allow the user to open individual GIS files for a project. When the user clicks the icon, a standard file selection dialog box will open that allows the user to browse to the desired directory and select the desired GIS file that he/she wishes to open. Once a file is selected, it will be added to the GIS legend and workspace.

**GIS File Save Function**

The purpose of this function is to allow the user to save individual GIS files that the user has created in a project. When the user clicks the icon, a file selection dialog box will open. This dialog box allows the user to select a file from a list of user-created GIS files; the user may then choose to save those files under a new name or in a different directory.

**Resample Grid Tool**

The purpose of this tool is to take an existing grid and allow the user to create a new grid from it with a different cell size. It also allows the North, South, East, and West positioning of the grid to be changed. An example of the form displayed for this tool is shown in Figure A14.
The user needs to select the existing grid file that he/she wishes to resample. This is done by clicking the “Browse” button at the top of the form, which opens a dialog box that allows the user to browse to the location of the grid file and then select the desired grid file. The user can specify the grid cell size and location information from another grid’s header (using the “Use existing grid as template” option) or by entering the information directly into the form (i.e., the Xmin, Xmax, Ymin, Ymax, Zmin, Zmax, and “Template cell size” fields) after selecting the “Specify new grid template” radio button. Note that Xmin corresponds to the lower left X-coordinate corner of the grid and that Xmax corresponds to the upper right X-coordinate corner of the grid. Note that Ymin corresponds to the lower left Y-coordinate corner of the grid and that Ymax corresponds to the upper right Y-coordinate corner of the grid. Zmin and Zmax correspond to minimum and maximum depth, respectively, if required. One final note is that cell size is assumed to be the same in both the X and Y directions (i.e., dX equals dY). Once the user specifies the output grid filename and clicks the “OK” button, the tool will try to create a new grid based on the user’s specifications. If the resampling is successful, the user will be prompted as to whether the new grid should be added to the workspace and, if so, then what short name to use for the grid file in the legend. If the grid resampling fails, then the tool will display a message indicating this to the user.
**Zoom In Function**

The purpose of this function is to allow the user to zoom into an area in the GIS workspace. After selecting this tool, the mouse pointer will change to a magnifying glass with a plus symbol, which will indicate to the user that the zoom in functionality is currently active. The user can left-click the mouse in the workspace and then drag and release the cursor over an area in the workspace. Once complete, the rectangle drawn will be zoomed into. Users with a scroll button on their mouse can move the scroll button forward to perform the same functionality.

**Zoom Out Function**

The purpose of this function is to allow the user to zoom out of the GIS workspace. After selecting this tool, the mouse pointer will change to a magnifying glass with a minus symbol, which will indicate to the user that the zoom out functionality is currently active. The user can left-click the mouse in the workspace and then drag and release the cursor over an area in the workspace. Once complete, the rectangle drawn will be zoomed out. Users with a scroll button on their mouse can move the scroll button backward to perform the same functionality.

**Pan Function**

The purpose of this function is to allow the user to move the focal point of the GIS workspace. After selecting this tool, the mouse pointer will change to a hand, which will indicate to the user that the pan functionality is currently active. The user can left-click the mouse in the workspace and then drag and release the cursor. After doing so, the focal point of the workspace will move in the direction that the user specified.

**AOI by Rectangle Tool**

The purpose of this tool is to allow the user to create an AOI in the GIS workspace. When the AOI is created, it creates a shapefile that corresponds to the AOI drawn by the user in the workspace. When the user selects this tool, a dialog box like that shown in Figure A15 is displayed.

This dialog box allows the user to specify the default shapeID that will be stored in the shapefile created for the AOI. The default value is 0, but the user can change it if so desired. The value should be an integer. After clicking the OK button, the mouse pointer will change to a crosshair icon.
The user can then left-click the mouse at a point in the workspace and, while holding the button down, drag a “rubberband” box over the extent of the AOI to be created. Once the user is satisfied with the AOI, release the left mouse button and a rectangle AOI will be created in the workspace. The user is then prompted as to whether he/she wishes to use the AOI that was drawn as shown in Figure A16. If not, then click the cancel button to start over. If the user is content with the AOI that was drawn, then he/she should provide a short name for the AOI in the “short name for this AOI” field, which will be used to identify the shapefile in the legend. The user can change the directory where the AOI’s corresponding shapefile will be stored, but it is suggested that the user accept the default location. Finally, the “OK” button should be clicked to add the AOI shapefile to the legend and workspace. The workspace will automatically zoom to the AOI that was created as shown in Figure A17.
Figure A17. An example of the zoomed workspace after adding an AOI.

**AOI by Polygon Tool**

The purpose of this tool is to allow the user to create an AOI in the GIS workspace. When the AOI is created, it creates a shapefile that corresponds to the AOI drawn by the user in the workspace. When the user selects this tool, a message similar to the one shown in Figure A18 is displayed. The message provides guidance to the user on how to use the tool. The message also conveys that a minimum of three points are required to create a polygon AOI; that the last point should be double-clicked to complete the polygon; and that the maximum number of points should be limited to 30. After acknowledging the message, a dialog box, like that shown in Figure A15, is displayed. After making any changes to the shapeID on the dialog box and clicking the “OK” button, the mouse pointer will change to a crosshair icon. The user can begin clicking out the points that will be used to create the polygon of the AOI. As each point is clicked, a line is drawn from the previous point to the current point. After double-clicking the last point, the tool will automatically complete the polygon with a final point, which matches the initial point, thereby closing the polygon for the user. The tool then operates similarly to that which was mentioned previously for the “AOI by Rectangle” tool.

**Measure Tool**

The purpose of this tool is to allow the user to measure length or area within the GIS workspace. When the user selects this tool, a dialog box like that shown in Figure A19 is displayed. The user must decide whether he/she wishes to measure length or area by selecting the appropriate radio button beside the appropriate option. Note that the topmost GIS layer in
the workspace should be georeferenced in order to use this tool. This should be true for most shapefiles, especially those distributed with the TREECS™ software for a given installation. Also note that the tool is dependent upon the map units that the user specified when creating the current project.

If the user wishes to measure length, then select the length radio button and click the “OK” button. The mouse pointer will change to a crosshair icon and X and Y coordinates will be displayed underneath the workspace. The user can left-click the mouse button in the workspace and, while holding it down, drag the cursor to the other point that coincides with the desired length between points. Once at the second point, the user can release the mouse button. The distance will be calculated and displayed under the legend control in the map units that the user specified for the project. This process may be repeated for each length that the user wishes to determine. An example of a measured length is shown in the lower left of Figure A20.
The procedure is somewhat similar for measuring an area in the workspace. The user first left-clicks the mouse in the workspace at the first point, then clicks the mouse at the next point and continues until at the last point. The user needs to double-click the last point in order to have the tool automatically close the polygon. After so doing, the tool will calculate the area and display the results under the legend as shown in Figure A21.

Convert Shapefile to Grid Tool

The purpose of this tool is to allow the user to use a shapefile as the basis for creating a grid file. When the user selects this tool, a dialog box like that shown in Figure A22 is displayed.
The user can select from the list of shapefiles in the current project or click the “Browse” button at the top of the dialog box to select a different shapefile. The new shapefile will then be added to the list of available shapefiles for possible conversion listbox.

Next, the user should select a shapefile in the listbox and then click the “Select this file” button. This will populate the “Selected shapefile to convert” field with the selected shapefile and then read information contained within the shapefile into memory as well as populate the “Available numeric fields in selected shapefile” listbox.

The user should then click the “Browse path” button to select the directory where the output grid file will be placed. After selecting the directory, the “Complete path and filename for the output grid file” field will be populated with the output directory. The user should then complete the output filename, including extension, in the remainder of the “Complete path and filename for the output grid file” field. Supported grid file extensions are “.ASC,” “.BDG,” or “.TIFF.” The “ASC” is for an American Standard Code for Information Interchange (ASCII) text grid file, the “BDG” (Binary Grid) is for a binary grid file, and the “TIFF” (Tagged Image File Format) is for a
binary image file. Note that “TIFF” files can exist as just an image file or as a grid file called a Geo-TIFF. Only the latter is supported for this tool. The user should then select the corresponding grid output type that matches the file extension on the output file in the “Grid output type desired” combobox.

The user should then select the desired numeric field that he/she wishes to incorporate into a grid file by selecting the appropriate field in the “Available numeric fields in selected shapefile” listbox and then clicking the “Select this field” button. This will then populate the “Selected” field and the “Selected field data type” fields. Note that only numeric data fields are supported for this tool.

The user should then select the appropriate option for a grid template. If it’s desirable to use the extent of the selected shapefile, then select the “Do not use a grid template” radio button. This will cause the resulting grid file to overlay the shapefile. If the user wishes to use an existing grid template (i.e., TGT file) for the grid header location information in the new grid file, then select the “Use existing grid template” option. The “Browse Templates” button must then be clicked to browse to the TGT template file and load the information into the “Grid template information” section of the dialog box. If the user wants to create a new grid template, then select the “Specify new grid template” radio button and then provide the information for the grid header in the “Grid template information” section of the dialog box. If the user wishes to save the template information for this option, then he/she can click the ”Save template” button to save the Xmin, Xmax, Ymin, Ymax, Zmin, Zmax, and “Template cell size” to a TGT grid template file for later use.

The final requirement is for the user to specify the grid cell size of the new grid. This is done by entering a value in the “Grid cell size” field.

After the user clicks the “OK” button, the tool will attempt to create a grid based on the information provided. If the operation succeeds or fails, a message will be displayed to the user indicating so. If the operation succeeds, then the tool will prompt the user as to whether he/she would like to add the grid to the workspace as shown in Figure A23. If the user selects “Yes,” then a dialog box like that shown in Figure A24 will be displayed.
Figure A23. A typical inquiry message about adding the new grid to the workspace.

Figure A24. An example of the prompt for a short name for the grid file.

If the user supplies a short name for the new grid file and clicks the “OK” button, then the short name will appear in the legend and the grid will be displayed in the workspace. An example of the workspace after adding the grid is shown in Figure A25.

Figure A25. An example of a workspace and legend after converting a shapefile to a grid and adding it to the workspace and legend.
Extract Subset Tool

The purpose of this tool is to allow the user to take a grid file that is larger than the user’s AOI and to use the AOI shapefile as a “cookie cutter” to extract a smaller portion of the grid into a new grid file that coincides with the extents of the AOI shapefile. When the user selects this tool, a dialog box like that shown in Figure A26 is displayed. Note that this tool only supports ASC grid files.

The user must select the existing larger grid file that he/she wishes to use. The user can either type the complete path and filename with extension in the “Grid filename” field or select the file by using the top “Browse” button which will allow the user to browse to the location of the file and select it directly. Next, the user must specify the AOI shapefile that is to be used as the “cookie cutter.” This is done by either typing the complete path and filename with extension into the “AOI shapefile” field or by clicking the corresponding Browse button which will allow the user to browse to the location of the file and select it directly. Next, the user must specify the name of the output grid file, including the path, filename, and extension. The user can type this information into the “Output grid filename” field or click the “Browse path” button to select the directory where the output file will be placed and then complete the “Output grid filename” field by providing the output filename and extension. Finally, the user should decide whether he/she wishes to extract grid cells contained entirely within the
AOI shapefile polygon or not. This is done by checking/unchecking the “Only extract grid cells contained entirely within the AOI shapefile polygon” checkbox.

Refer to the schematic in Figure A27, which provides information that will help with the use of this tool. In this figure, the numbered blue squares compose the larger GIS grid from which we need to extract a smaller grid. The black curve represents the AOI shapefile that the user previously created and which will be used as the “cookie cutter.” If the user checks the “Only extract grid cells contained entirely within the AOI shapefile polygon” checkbox when creating the grid extract, then the resulting grid will be composed of grid cells 8, 9, 13, and 14. However, if the user does not check the checkbox, then the resulting grid will be composed of grid cells 2, 3, 4, 5, 7, 8, 9, 10, 12, 13, 14, 15, 17, 18, 19, and 20.

![Figure A27. Grid and shapefile schematic for help with using the Extract Subset Tool.](image)

Once the user clicks the “OK” button on the tool’s dialog box, the tool will inform the user with a message as to whether the operation succeeded or failed. If it succeeded, then the tool will ask the user whether he/she wishes to add the grid to the workspace. If the user selects “Yes,” then the tool will then prompt the user for a short name for the new grid that will
be used to identify the grid in the GIS legend. After clicking the “OK” button, the new grid will be added to the workspace and legend. An example is shown in Figure A28.

![Figure A28. An example of the new grid created with the Extract Subset Tool.](image)

**Map Grid Calculations Tool**

The purpose of this tool is to allow the user to create a slope grid from a digital elevation model (DEM) or to perform simple mathematical operations such as multiplication, division, addition, and subtraction on a grid. When the user selects this tool, a dialog box like that shown in Figure A29 is displayed.

![Figure A29. The Map Grid Tool dialog box.](image)
If the user selects the “Create a slope grid from a DEM” option and clicks the “OK” button, then a dialog box like that shown in Figure A30 will be displayed. On this dialog box, the user must select the DEM file that is to be converted to a grid and provide the filename for the resulting output grid file. These are specified in the “DEM to be used” and “Output grid to be created” fields, respectively. The user can either type the complete path, filename, and extension into the fields or use the “Browse” button to select the DEM and the “Browse Path” button to specify the drive and directory where the output file will be placed. If using the latter, then the user must complete the filename and extension for the file. Note that the only grid format supported for the output file is the ASCII grid file (i.e., “.asc” extension). The supported DEM file formats are the U.S. Geological Survey (USGS) DEM format (http://rockyweb.cr.usgs.gov/nmpstds/acrodocs/dem/2DEM0198.PDF) as well as the ASCII grid file (i.e., “.asc” extension).

![Figure A30. The Slope Grid form for the Map Grid Calculations Tool.](image)

After the user provides the filenames and clicks the “OK” button, the tool will run a few support applications to create the slope grid. These support applications will appear in command prompt windows and will automatically close once complete. After these support applications complete, and if their operations were successful, then the tool will ask the user whether he/she wishes to add the slope grid to the workspace. If the user clicks the Yes button, then the tool will prompt the user to provide a short name for the slope grid, which will appear in the legend. After the user provides the short name, the tool will add the new grid to the legend and workspace. An example of a resulting slope grid is shown in Figure A31 as it appears in the legend and workspace.
If the user wishes to use one of the multiply, divide, add, or subtract options of the map grid calculations tool, then the user should select the desired option on the main dialog box of the tool and click the “OK” button. An example of the resulting form for the “Multiply all values in a grid by a number and create a new grid” is shown in Figure A32 and discussed below. The other divide, add, and subtract operations work similarly to that described for the multiply operation.

For the “Multiply all values in a grid by a number and create a new grid” option, the user must select the grid to perform the multiply operation upon, specify the output grid file (including the complete path, filename,
and extension), and provide the value by which all grid cells are to be multiplied. These are provided in the ‘Existing grid to be used,’ “Output grid to be created,” and “Value to multiply each cell value by” fields, respectively. After providing the information and clicking the “OK” button, the tool will generate a new grid with all grid cell values multiplied by the specified value. If the operation is successful, the tool will prompt the user as to whether to add the new grid to the workspace. If the user clicks the Yes button, then the tool will prompt for a short name for the new grid, which will be displayed in the legend. An example of a resulting grid from a multiply operation as displayed in the legend and workspace is shown in Figure A33.

![Figure A33. An example of a new grid created for a multiply operation.](image)

### Tutorial for Developing Grid Files for Use with HGCT

This section provides a tutorial on developing grid files for use with the HGCT. One item to note is that shapefiles (.SHP) have associated with them a shapefile index (.SHX) and a dBase® database file (.DBF). Once the user has created a new TREECS™ project, selected the installation, and created an AOI, the user needs to create the grid files that will be used if he/she desires to use the HGCT in spatial mode. There are typically four grid files required to use the HGCT in spatial mode and each one should exactly overlay one another when viewed in the TREECS™ workspace or some other GIS application. Each of these grid files is described below.

#### AOI Grid File

After creating an AOI using the AOI tool of TREECS™, the user should use the “Convert Shapefile” to “Grid” tool described in a previous section of this
appendix to create a grid that corresponds to the AOI. The AOI that we use for this tutorial is shown in Figure A34. Figure A35 shows an example of the use of this tool for converting an AOI shapefile to a grid with a cell size of 30 m.

After clicking the “OK” button on the dialog box, the tool will attempt to create a grid from the AOI shapefile. If the operation succeeds, the tool will prompt the user as to whether he/she wishes to add the grid to the workspace. The user may proceed with either option, but he/she should take note of the file and its location since he/she will have to provide it when using the HGCT. The resulting grid is shown in Figure A36 and is ready for use in the HGCT. The actual format of the grid file is that of the Environmental Systems Research Institute (ESRI) ASCII grid file (http://en.wikipedia.org/wiki/Esri_grid).

**Soil Texture Grid File**

The user must obtain a soil texture grid that encompasses the AOI. The user may already have this grid from previous work or may have a shapefile with the soil texture information in it which subsequently needs to be converted to a grid. If the user already has a grid file with this information, then he/she can use either the “Extract Subset Tool” or the “Resample Grid Tool” described previously in this appendix to create a grid that corresponds to the AOI.

Figure A34. The AOI shapefile used in this tutorial.
If the user has the shapefile, then he/she can use the “Convert Shapefile to Grid” tool to create a grid file. An example is shown in Figure A37. However, if the soil texture information in the shapefile’s corresponding DBF file is
not a numeric field, then the user must first convert it to a numeric field prior to using this tool. See the MUKEY field shown in Figure A38, which displays some typical soil texture classification information after it was converted from text to integer (i.e., numeric). Note that any field type and corresponding data conversions must be done outside of TREECS™. The user can utilize a GIS application, MS Access and MS Excel, or dBase IV to modify the field type in the DBF file that corresponds to the shapefile. A description of how to use these options is beyond the scope of this report and left to the user as an exercise. After converting the shapefile, the resulting grid file must be reduced to one that coincides to the AOI by using the “Extract Subset Tool” as shown in Figure A39. The resulting soil texture grid that corresponds to the AOI is shown in Figure A40 and is ready for use in the HGCT.

**Land Cover Grid File**

The user must obtain a land cover grid that encompasses the AOI. The user may already have this grid from previous work or may have a shapefile with the land cover information in it which subsequently needs to be converted
Figure A38. An example of the MUKEY soil texture classification information in a DBF file.

![Figure A38]

Figure A39. An example of extracting a subset from the previously created grid.

![Figure A39]
Figure A40. An example of soil texture grid that coincides with the AOI.

to a grid. If the user already has a grid file with this information, then he/she can use the “Extract Subset Tool” described previously in this appendix to create a grid that corresponds to the AOI.

If the user has a shapefile with the information, then he/she can use a procedure similar to that described for the soil texture grid file above as it pertains to the use of a shapefile. We will assume that the user already has a large grid that encompasses the user’s AOI.

If we have the land cover grid file shown in Figure A41 and the AOI shapefile shown in Figure A34, then we can use the “Convert Shapefile to Grid” tool to create a grid file with land cover information that coincides with the user’s AOI.

Figure A41. An example of a land cover grid that encompasses the user’s AOI.
Figure A42 shows the main dialog box of the tool with the input fields populated and the checkbox for only extracting grid cells contained entirely within the AOI shapefile selected. When the “OK” button is clicked, the tool will create a grid file of land cover that coincides with the AOI.

![Figure A42. The Extract Subset tool’s main dialog box for the land cover grid.](image)

The resulting grid as it appears in the TREECS™ legend and workspace is shown in Figure A43, which is subsequently ready for use in the HGCT.

![Figure A43. The resulting land cover grid that coincides with the user’s AOI.](image)
**Slope Grid File**

To create a slope grid, the user must first obtain a DEM that encompasses the user’s AOI. After so doing, the user can use the “Map Grid Calculations” and the “Extract Subset” tools to create the necessary grid file for the HGCT. Here, it is assumed that the user has obtained a DEM named “dem_30.asc” and which resides in the user’s “C:\temp\” directory. The DEM is converted to the slope grid “C:\temp\slopeGrid_30.asc.” The specification of these within the “Map Grid Calculations” tool is shown in Figure A44. When the user clicks the “OK” button, a series of support applications will run and create a slope grid. An example of the resulting slope grid as it appears in the TREECS™ legend and workspace is shown in Figure A45.

![Figure A44. The Map Grid Calculations Tool/Create a Slope Grid from a DEM main dialog box.](image1)

![Figure A45. An example of the resulting slope grid that encompasses the user's AOI.](image2)
The user next needs to use the “Extract Subset” tool to create a grid of the slope information that coincides with the user’s AOI. Figure A46 shows the inputs for this tool. Figure A47 shows the resulting grid as it appears in the TREECS™ legend and workspace. This grid is ready for use with the HGCT.

Figure A46. An example of the Extract Subset tool showing the inputs for creating a slope grid that coincides with the user’s AOI.

Figure A47. An example of the resulting slope grid that coincides with the user’s AOI.
Appendix B: Using the HGCT

Background

The hydro-geo-characteristics toolkit (HGCT) is designed to aid the user in determining some of the input variables required by the TREECS™ models. The tool can estimate soil properties, soil erosion rate, hydrology (e.g., infiltration, runoff, evapotranspiration (ET), etc.), as well as Darcy velocity. The tool additionally allows the user to estimate these from point (single value) and spatially varying composite input data. In order to use the spatial option, several GIS map files (i.e., grids) need to be created before using the tool. These GIS files can be created with the GIS tools incorporated into TREECS™ itself or from externally developed map files. See the last section of Appendix A for help with creating the grid files using the various TREECS™ GIS tools. The computed output of the HGCT can be imported into the Tier I and II soil model user-interfaces by using the appropriate File menu Load/Reload HGCT Applicable Data or “Load/Reload HGCT Data” menu item options of these user-interfaces, respectively.

It should be recognized that both the Tier 1 and Tier 2 soil fate models assume homogeneity throughout the AOI. That means the soil properties and MC concentrations are uniform throughout the AOI used by the soil models. Furthermore, the soil models use only long-term annual averages for hydrology and properties. Thus, it is only necessary to provide single values for soil properties and hydrologic inputs of the AOI. Even if the spatial mode of HGCT is used, the spatially varying properties and hydrology will be processed to provide an AOI-wide average for each of these inputs.

The remainder of this appendix covers the usage of HGCT with regard to its operation in the two modes that it supports (i.e., point and spatial).

HGCT Point Mode

When operating the HGCT in point mode, the user typically enters average soil, erosion, hydrology, and Darcy velocity properties/information. There is an extensive amount of help information available to the user under the Help menu. A description of each of the tabs of the user interface when operating in point mode is discussed below.
Soil Properties

The “Soil Properties” tab of the HGCT in point mode is shown in Figure B1. The user can either: 1) choose the soil texture from the listbox in the upper right corner of the tab and have the HGCT automatically fill out the soil property information for the user; or 2) provide the soil properties directly. The properties include porosity, volumetric soil moisture content, dry bulk density, and saturated hydraulic conductivity. The saturated hydraulic conductivity is shown in two different units (i.e., cm/s and cm/day).

![Figure B1. The Soil Properties tab of HGCT in Point mode.](image)

Erosion

The “Erosion” tab of the HGCT in point mode is shown in Figure B2. The calculation of the erosion rate is based on the United States Department of Agriculture (USDA) Universal Soil Loss Equation (USLE).
\[ A = RKLSCP \]  \hspace{1cm} (B1)

where

- \( A \) = Average annual soil loss, tons/acre/yr
- \( R \) = Rainfall erosivity factor, dimensionless
- \( K \) = Soil erodibility factor, dimensionless
- \( LS \) = Slope length gradient factor, dimensionless
- \( C \) = Crop management factor, dimensionless
- \( P \) = Conservation practice factor, dimensionless.

Figure B2. The Erosion tab of HGCT in Point mode.
The default value for “P” is 1.0 for firing ranges. LS is computed based on
the L and S topographic factors. The help files can provide assistance to
the user in specifying the R, K, C, and P factors.

In addition to specifying the USLE input parameters, the user must select
which method to use for computing the soil loss type (i.e., “SDR,” or
“Without SDR”). If the user selects the sediment delivery ratio (SDR) soil
loss type, then the user must also enter the AOI area in square miles.

**Hydrology**

The “Hydrology” tab of the HGCT in point mode is shown in Figure B3.
The calculation of the hydrology information is based on the USDA Soil
Conservation Service (SCS) Curve Number (CN).

\[
Q = \frac{(P - I_a)^2}{P - I_a + S} \quad (B2)
\]
where

\[ Q = \text{Runoff, in} \]
\[ P = \text{Rainfall, in} \]
\[ S = \text{Potential maximum soil moisture retention after runoff begins, in} \]
\[ I_a = \text{the initial abstraction, in, or the amount of water before runoff, such as infiltration, or rainfall interceptions by vegetation. It is generally assumed that } I_a = 0.2S. \]

The runoff CN is then related by the equation

\[ S = \frac{1000}{CN} - 10 \quad (B3) \]

Note that CN usually ranges between 30 and 100. The hydrologic computations also take into account evapotranspiration and snow accumulation and melt. Infiltration is computed from a water balance. The hydrologic computations are explained in greater detail by Dortch et al. (2011b).

The user must enter the CN as well as the starting year, total number of years, the latitude type (i.e., northern or southern hemisphere), the latitude value, snow evaporation, lagging factor, melt factor, and the antecedent moisture content (AMC). Help files and tool tips can assist the user in specifying the input values. The user must also specify the file names for the precipitation and temperature data. The format of the precipitation file is shown graphically in Figure B4, which is year, month, day, and precipitation in inches/hour. The format of the temperature file is shown graphically in Figure B5, which is year, month, day, mean temperature (deg. C), and maximum temperature (deg. C). After entering the required inputs, the user can click the “Run” button to compute the hydrology. The output is displayed at the bottom of the screen as shown in Figure B3. Output can also be automatically transferred to the soil model input UIs as mentioned previously.

**Darcy Velocity**

The “Darcy Velocity” tab of the HGCT in point mode is shown in Figure B6. The calculation of the Darcy velocity is based on the equation
Figure B4. The format of the precipitation file.

Figure B5. The format of the mean and maximum temperature file.

Figure B6. The Darcy Velocity tab of HGCT in Point mode.

\[ V_d = K_s \frac{dH}{dx} \]  \hspace{1cm} (B4)

where

\[ V_d = \text{Darcy velocity, cm/day} \]
\[ K_s = \text{Saturated hydraulic conductivity, cm/day} \]
\[ dH = \text{Change in head between two wells, m} \]
\[ dx = \text{distance between wells, m} \]

Note that the \( K_s \) value initially displayed on this tab is passed from the saturated hydraulic conductivity value on the “Soil Properties” tab.
However, the value of Ks for the aquifer is usually different than the value for surface soil.

HGCT Spatial Mode

When operating the HGCT in spatial mode, the user supplies grid cell-based SCS curve number, land use, soil texture, and surface slope information into tables associated with grids. Darcy velocity information for spatial mode is the same as that described above for point mode. There is an extensive amount of help information available to the user under the “Help” menu. A description of each of the tabs of the user interface tabs when operating in spatial mode is discussed below.

Soil Properties

The “Soil Properties” tab of the HGCT in spatial mode is shown in Figure B7. The user must supply the filename for the soil texture map (i.e., grid file), the AOI map filename, and soil specific gravity. The user can then click the “Run” button to compute the average soil properties. It should be noted that the AOI map file is the grid file created by the user in the “AOI Grid File” section of the “Tutorial for Developing Grid Files for Use with HGCT” section of Appendix A, which was developed with the “Convert Shapefile to Grid GIS” tool of TREECS™. It should also be noted that the soil texture map file is the grid file created by the user in the “Soil Texture Grid File” section of the same Appendix. However, the HGCT requires additional information from the user for the soil texture map file before it can be used. This additional information is specified on the dialog box that appears when the user clicks the “Edit Table” button in Figure B7. This dialog box is shown in Figure B8.

The soil texture table initially contains only the soil texture IDs that are directly obtained from the associated grid file. The user must then supply the remainder of the information required. This includes mapping the ID to the soil texture description (i.e., sand, loamy sand, sandy loam, etc.), specifying the porosity, field capacity, dry bulk density, saturated hydraulic conductivity, soil erodibility factor (i.e., K factor), and selecting the hydrologic soil group (i.e., A, A/B, B, etc.) associated with each soil texture ID. Note that the porosity, field capacity, dry bulk density, and saturated hydraulic conductivity fields of the table are automatically populated for the user once he/she selects the soil texture associated with the soil texture ID. However, the user can change these if desired. Soil textures can be selected by clicking and selecting a texture within the combo box in each soil texture ID.
texture/ID box. There are help files in the soil texture table menu that provide information for selecting the K factor and hydrologic soil group. Once the user has supplied all of the required information in the table, the user can click the “File” menu and then select the “Save” menu item to save the information to the soil texture table file (i.e., “soils.tbl”).

Finally, the user should click the “Run” button to produce the output shown in the bottom panel of Figure B7. The output represents the AOI spatial average of each parameter based on the spatially varying soil textures and the associated soil properties.
Erosion

The “Erosion” tab of the HGCT in spatial mode is shown in Figure B9. The calculation of the erosion rate is based on the USLE as was described for the point mode of HGCT. However, several of the values in the USLE are spatially based in spatial mode; therefore, the user must supply some information that is grid based.

The same soil texture map file (grid) and its associated table — as well as the AOI map file that was specified on the “Soil Properties” tab — are used on the “Erosion” tab. However, this tab also requires a land use map file (grid) and table as well as a slope map file. These two map files are the ones that the user created in the “Land Cover Grid File” and “Slope Grid File” sections, respectively, of the “Tutorial for Developing Grid Files for Use” with HGCT section of Appendix A. The user can click the “Browse” button associated with each of these map files and select the appropriate map files to be used. The user must provide additional information for the land cover map file by clicking the Edit Table button associated with the “Landuse Map Filename” field. Once the user clicks this button, a dialog box similar to that shown in Figure B10 will appear.
The “Landuse Table” initially only contains the landuse IDs that are directly obtained from the associated land cover grid file. The user must then supply the remainder of the information required. This includes mapping the ID to the landuse description (i.e., water, developed open space, grassland, etc.); specifying the crop management factor (i.e., C Factor); and the conservation practice factor (i.e., P Factor) associated with each landuse ID. It should be noted that the P Factor defaults to 1 for conservatism for firing ranges, and the C Factor defaults to 0 for each landuse ID, but the user can change these if desired. Values other than zero should be entered for the C factor in order to have erosion. The greater the C factor, the greater the erosion rate. Thus, erosion rates for water should be essentially zero or very small values, as
shown in Figure B10. There is a help file to assist in selecting C factors. The user must provide a description of each landuse ID in the form of a short textual description. Once the user has supplied all of the required information in the table, the user can click the “File” menu and then select the “Save” menu item to save the information to the landuse table file (i.e. “landuse.tbl”).

The user must also supply a single Rainfall factor (R) value, for which there is a help file with a map of the U.S. with R factor contours. Once the user has supplied all of these inputs, then the “Run” button will be enabled and should be clicked to produce the output shown in the bottom portion of Figure B9. The output represents the AOI spatial average based on spatially varying inputs associated with the map files and their associated tables. Finally, the user should select the appropriate “Soil Loss Type” value in the combobox (“Without SDR” or “SDR”). Using the “Soil Delivery Ratio” (SDR) reduced the amount of erosion due to trapping of eroded sediments within the AOI before leaving the AOI. The SDR method is empirically
based as described by Dortch et al. (2010). The erosion rates are shown in two forms, mass per unit area per time (tons/acre/yr) and soil thickness eroded per time (m/yr), which is based on soil bulk density. The values change when the user chooses between “SDR” and “Without SDR.”

**Hydrology**

The “Hydrology” tab of the HGCT in spatial mode is shown in Figure B11. The calculation of the hydrology information is based on the CN, as was described for the point mode of HGCT. However, in spatial mode, some of the input information (i.e., soil texture, landuse, and curve number) is grid based. The soil texture and landuse map files are the same as those from the “Erosion” tab. Therefore, the user only needs to supply the additional grid based information for the CN.

![Figure B11. The Hydrology tab of HGCT in Spatial mode.](image)
The grid-based CN input information is specified by the user by clicking the “Edit Table” button beside the “Compute” button, which is next to the Composite AOI SCS Curve Number. Clicking this button will bring up a dialog box like that shown in Figure B12. The “Landuse ID” column coincides with those IDs from the landuse table. The soil group columns in the table are automatically obtained from the soil texture table that the user specified. The landuse description information is automatically obtained from the landuse table that the user previously provided and cannot be edited by the user on this dialog box. The user must go back to the landuse table and change landuse descriptions in order for those changes to be reflected here. In addition, the user must provide the curve numbers associated with each landuse ID and for the applicable soil group. The default CN for each soil group is zero. CN values typically range between 30 and 100. There is help file information on the menu bar of this screen to assist with setting CN values. After completing the table, the user should either click the “OK” button at the bottom of the screen to save the table and exit or click the “save” button on the menu bar and then click the “Cancel” button to exit. The information to the CN table file is saved in a file with the name “cn.tbl.” After saving the CN table, the user should click the “Compute” button to produce the composite AOI SCS CN. This value is the AOI spatially averaged CN that will be used to compute the hydrologic variables.

![Image of CN table](image)

Figure B12. An example CN table for the Hydrology tab of HGCT in Spatial mode.
The file names for the historical precipitation and air temperature data must be entered as shown in Figure B11. These files are the same as those described previously for the “Hydrology” tab of the point model of HGCT. The other input parameters listed after these input files must be entered as described before for the “Hydrology” tab of the point model of HGCT. There are various help tips next to each parameter field to assist in setting these values. After completing the inputs, the user should click the “Run” button to produce the output shown in the bottom portion of Figure B11. The output represents the long-term annual average value for the AOI. These outputs can be automatically transferred to the Tier 1 or 2 soil model by clicking the “Load/Reload HGCT Applicable Data” button under “File” in the menu bar of the model UI.

**Darcy Velocity**

The “Darcy Velocity” tab in spatial mode operates the same as that described in point mode in the previous section for the point mode of HGCT.
Appendix C: Using Database Editors

This section discusses the various database editors available to the user and found under the “Tools” menu. These editors allow the user to create user-defined constituent, munition, and health benchmark databases. Each of these is described below.

Constituent Database Editor

The FRAMES constituent database used in TREECS™ was originally developed by PNNL (http://mepas.pnl.gov/FRAMESV1/mmede.stm) and a copy of it can be found in “C:\Prog Files\TREECS\Databases\CopyOfFui.mdb.”

The user can create or modify a user-defined constituent database by selecting the “Constituent Database Editor” option from the “Tools” menu of TREECS™. When the user selects this option, a form like that shown in Figure C1 is displayed.

Figure C1. The Constituent Database Editor main form.
The main form has three main menus: “File,” “Tools,” and “Help.” Using the “File” menu (Figure C2), the user can create a new constituent database (using “New”), open an existing constituent database (using “Open”), close the current database (using “Close”), discard current changes and restore from a backup copy of the database prior to the last changes that were saved (using “Restore” from DB), save the current database (using “Save”), save the current database under a new name (using “Save As”), print the current database (using “Print”…), set the printer properties (using “Print Setup”), or exit (using “Exit”). The “Save” and “Exit” option will save the current changes to the current database and then exit the editor. Note that the Restore from GID menu item is not applicable to TREECS™.

![Figure C2. The Constituent Database Editor’s File menu.](image)

The “Tools” menu item (Figure C3) allows the user to add multiple values for a given constituent property (using “Property Criteria Wizard”…) and to specify references for constituent property values (using “References”…). Note that the user can supply multiple parameter values for a given constituent with the “Property Criteria Wizard,” but this is not applicable to use in TREECS™. It could apply if the user were to use a user-defined database in
ARAMS or FRAMES, however, and needed to be able to select from among multiple values for a given parameter of a constituent. A brief introduction to the use of this wizard is provided later in this section for those interested.

![The Constituent Database Editor's Tools menu.](image1)

The “Help” menu item (Figure C4) allows the user to get help using the editor (using How to... F1) and displays information about the editor itself (using “About”).

![The Constituent Database Editor's Help menu.](image2)

To create a new user-defined constituent database, the user can either begin with a blank database or start from a copy of the FRAMES constituent database installed with TREECS™ and save it with a different name. The latter is located in the C:\Prog Files\TREECS\Databases\ directory as CopyOfFui.mdb.

To begin with a blank database, the “New” menu item should be selected and then a filename should be provided for the database in the “Open File” dialog box that is immediately displayed after selecting this menu item. After supplying the filename for the new database, the editor will prompt the user to create a corresponding FRAMES description file as shown in Figure C5. If the user intends to only use the user-defined database that he/she is creating in TREECS™, then the “No” button should be clicked on
this prompt. It will not be used in TREECS™ even if the “Yes” button is clicked. If the user intends to also use this database in ARAMS or FRAMES, then he/she can click the “Yes” button to create a description (DES) file that can then be used with these other software programs. After making a selection, the editor will display a form like that shown in Figure C6.

Figure C5. The FRAMES description file prompt for a New database.

Figure C6. The initial form for a New database.
Since the database is new and there are no existing constituents, the first tab (i.e., “Select Constituents of Concern”) of the form in Figure C6 is not applicable. The user must proceed to the second tab, “Edit Constituent Properties.” This tab is shown in Figure C7.

The user must first add a constituent using the Identification sub-tab. To do this, he/she must click the “New” button on this tab/sub-tab combination. This will bring up a dialog box like that shown in Figure C8. The user will need to provide a CASRN and the common name for the constituent in this dialog box. Note that the CASRN should not contain any hyphens. For example, for CASRN 118-96-7 (2,4,6-trinitrotoluene), the user would enter a CASRN of “118967” and supply either “TNT” or “2,4,6-trinitrotoluene” as the common name. He/she should then click the “OK” button to add the constituent to the database or click “Cancel” to abort the add operation.

Once the user has added a constituent, he/she can provide synonyms for it by typing them directly into the “Synonyms” listbox on the form. The user should then supply the chemical type by selecting the appropriate item in the corresponding combobox. Next, he/she supplies the periodic group for
the constituent by selecting the appropriate option from the corresponding combodbox. He/she should then supply the appropriate exposure type for
the constituent by selecting the appropriate option from the corresponding combobox. Finally, the user should select the appropriate RAAS (Remedial
Action Assessment System) type for the constituent by selecting the appropriate option from the corresponding combobox. Once completed, the
entry should look somewhat similar to Figure C9.

![Figure C8. The dialog box for a New constituent.](image)

![Figure C9. An example of the Identification properties for a new constituent.](image)
Once the user has entered the basic identification information for a new constituent, then he/she can begin entering properties for the constituent. This is done on the “Properties” sub-tab of the “Edit Constituent Properties” tab. This sub-tab is shown in Figure C10.

![Figure C10. The Properties sub-tab.](image)

On this sub-tab is where the user selects the desired property to be entered and then supplies the value in the corresponding Value cell and in the specified units. If the user attempts to supply a value that is outside the range of allowed values, then the background color of the Value cell will change to red. Optionally, the user can supply a reference for the value entered by double-clicking in the Ref cell or by single clicking in it and then selecting the Tools → References... menu item. This will bring up a dialog box like that shown in Figure C11, where the user can either select from the list of existing references or add a new reference. The “New” button on the dialog box can be clicked to enable the short name and corresponding full reference description textboxes. A short name and full reference can then be provided. If there are existing references already, the user can select the desired reference and edit it using the “Edit” button. Once complete with adding or selecting a reference, the user can click the “Close” button to close
the dialog box without selecting a reference or click the “Apply” button to place the currently selected reference ID in the corresponding “Properties” sub-tab’s Ref cell.

If desired, the editor can estimate some of the constituent properties for the user. This is done by clicking the “Estimate...” button on the “Properties” sub-tab. This will bring up a dialog box like that shown in Figure C12. A detailed description of this functionality is beyond the scope of this document and therefore the user is referred to the help information available on that dialog box for additional information. Help is available by clicking the Help... (F1) menu, or by clicking in a field and then pressing the F1 function key. In general, once the user has estimated the desired properties, then he/she can click the appropriate “Apply” checkboxes for the desired estimated properties. This will populate the corresponding property values on the “Properties” sub-tab.
The user can also specify the degradation products for a constituent on the “Degradation Products” sub-tab. However, the user should note that in the current version of TREECS™ this information is not used.

If the user decides to use it nonetheless, then he/she will not be able to edit the degradation products for that constituent if it is currently selected on the “Select Constituent of Concern” tab. He/she must first deselect the constituent before assigning degradation products. The user must also ensure that he/she has already included the degradation products as database constituents so that he/she can select them as degradation products for a given constituent. The example shown in Figure C13 uses TNT as an example. Two degradation products, 4-ADNT and 2-ADNT were previously entered as individual constituents on the “Identification” sub-tab. While on the “Degradation Products” sub-tab, the user selects TNT in the listbox at the top of the dialog box. Then in the “Available constituents” listbox, he/she selects the desired primary degradation product (e.g., 4-ADNT) and clicks the >>> button next to the primary branch. Next, the user supplies the fraction for the occurrence of that degradation product in the primary branch “Fraction” field. The fraction is used to specify that...
fractional part of the parent constituent mass that goes into the degradation product(s). This subsequently provides a means for specifying preferential degradation products of a parent constituent. Next, the user selects a secondary branch degradation product and clicks the >>> button next to the secondary branch (e.g., 2-ADNT) and then provides the fraction for the occurrence of that degradation product in the secondary branch “Fraction” field. This process is repeated for all desired constituents. For this editor, there can only be two degradation products for each parent constituent.

To view all existing degradation information for constituents, the user can select the “Degradation Chain” sub-tab. This sub-tab is designed only for viewing degradation products entered by the user on the “Degradation Products” tab. This will allow the user to select a constituent from the listbox at the top and to see all degradation chains for the selected constituent. An example of this sub-tab is shown in Figure C14. The “Straight Degradation” tree will show the selected constituent and its primary
degradation chain. The “Branch Degradation” tree will show the constituent and any primary and secondary branches that the user entered for it on the “Degradation Products” tab. The user can double click the parent constituent in the “Branch Degradation” tree and the child nodes of the tree will expand and collapse. After making all changes, the user should click the “File” menu’s “Save,” “Save As,” or “Save and Exit” as appropriate to save the current database and remain in the editor, save the changes to a different database and remain in the editor, or save the changes to the current database and exit the editor, respectively.

As mentioned earlier in this section, the “Property Criteria Wizard” is available for utilization, but it is not applicable for use in TREECS™. Here the functionality of this wizard is discussed.

If the user selects the “Property Criteria Wizard” from the “Tools” menu, a dialog box like that shown in Figure C15 will appear.

To view only existing properties with a user-designated criteria, the user can check the “View only Properties with Criteria” checkbox. This will update the dialog box like that shown in Figure C16 and will show in the right-hand
panel all criteria entered by the user regardless of the currently selected constituent in the combobox on the right-hand panel. Additionally, the left-hand panel will reduce to only those parameters for which the user has provided criteria.

Figure C15. The Property Criteria Wizard.

Figure C16. The Property Criteria Wizard showing usage of the View only Properties with Criteria checkbox.
To view criteria for only populated constituents, the user can check the “View only Populated Constituents” checkbox. This will change the constituents available for selection in the associated combobox located in the right panel and also show all criteria and associated value and any user-supplied references for them. An example of this is shown in Figure C17.

![Figure C17. The Property Criteria Wizard showing usage of the View only Populated Constituents checkbox.](image)

To add a new criterion, the user must first select a parameter in the left-hand panel and then click the “Add Criteria” button. This will bring up a dialog box like that shown in Figure C18 and will associate the criteria that the user enters with the selected property. After clicking the OK button, the main dialog box will update to reflect the addition of the new criteria for the selected parameter as shown in Figure C19. The user will be able to add a value to the new criterion for the selected parameter for all constituents in the constituent database.

If the user would like to delete a criterion, then he/she can select the criterion in the right-hand panel and click the “Delete Criteria” button. A prompt will appear confirming the user’s desire to delete the selected criteria. If the user selects “Yes,” then the criteria will be removed from the database for the selected parameter. Selecting “No” will abort the delete operation.
Once a criterion has been provided by the user in the wizard, the user will be able to provide a parameter value for the criterion on all desired constituents. The user first selects a constituent in the right-hand panel and then provides a value for the criterion and an associated reference. The user can add or select a reference by double-clicking in the “Ref” field. This will bring up a “References” dialog box like that shown in Figure C20, where the user can select from any existing references or add a new reference. Once the desired reference is selected, the user can click the “Apply” button to have the reference ID on the “Property Criteria Wizard” update accordingly.
Once the user has made all desired changes with the “Property Criteria Wizard,” he/she should click the “OK” button or click the “Cancel” button to discard his/her changes. After making all changes, the user should click the “File” menu’s “Save,” “Save As,” or “Save and Exit” as appropriate to save the current database and remain in the editor, save the changes to a different database and remain in the editor, or save the changes to the current database and exit the editor, respectively.

**Benchmark Database Editor**

The user can create or modify a user-defined health benchmark database by selecting the “Benchmark Database Editor” option from the “Tools” menu of TREECS™. When the user selects this option, a form like that shown in Figure C21 is displayed.

The main form has two main menus: “File” and “Help.” Using the “File” menu (Figure C22), the user can create a new health benchmark database (using “New”); open an existing health benchmark database (using “Open”);
close the current database (using “Close”); save the current database (using “Save”); save the current database under a new name (using “Save As”); or exit (using “Exit”).

The “Help” menu item (Figure C23) allows the user to get help on using the editor (using Help) and displays information about the editor itself (using “About”).
To create a new user-defined health benchmark database, the user can either begin with a blank database or start from a copy of the DoD default target health benchmark database installed with TREECS™ and save it under a different name. The latter is located in the C:\Prog Files\TREECS\Databases\ directory as TreecsBenchmarksRevised.mdb.

To begin with a blank database, the user should utilize the “New” menu item and then provide a filename for the database in the “Open File” dialog box that is immediately displayed. After supplying the filename for the new database, the user can then begin creating his/her own user-defined health benchmark database that can be used in TREECS™.

The first thing that the user needs to do is to enter the constituents. This is done on the “Constituents” tab using the “Add” button. When he/she clicks the “Add” button, a dialog box like that shown in Figure C24 will appear.

The user is required to enter a valid CASRN for a new constituent and provide the name of the constituent. The CASRN must be in its true form with hyphens and composed entirely of numbers (i.e., [###]###-###-#). An example would be 118-96-7, which is the CASRN for TNT (2,4,6-trinitrotoluene). After supplying the information on the dialog box, the user can click the “OK” button to add the constituent to the data grid on the “Constituents” tab. If the editor detects any problems with the user’s inputs for the constituent CASRN or name, then a message will be displayed to the user stating what problem was found. The user will have to rectify the problem before the editor will accept the input. If the user clicks the “Cancel” button on the dialog box then the operation will be aborted. It should be noted that no information is written to the selected database until the user clicks the “Save” or “Save As” menu items in the “File” menu.
Once the user has entered a constituent, the constituent can be edited or deleted by clicking the “Edit” or “Delete” buttons, respectively, in the data grid corresponding to the specific constituent. The “Edit” button will bring up the same dialog box used for entering a new constituent. The user can then make the desired changes. If the user clicks the “Delete” button, a prompt will be displayed confirming that the user actually wishes to delete the selected constituent. The “Yes” button can be clicked to delete the constituent, or the “No” button can be clicked to cancel the delete operation.

The user can add a source by first clicking on the “Sources” tab. Figure C25 shows an example of this tab. A source is intended to establish information as to where a benchmark value was obtained (e.g., EPA Regional Screening Levels for Chemical Contaminants at Superfund Sites). The user can add a source by clicking the “Add” button. This will bring up a dialog box like that shown in Figure C26.

The user should provide a short name for the source as well as a full description of the source. The short name is to be entered into the “Source Short Name” field and the full description is to be entered into the “Source Full Description” field. After supplying the required information, the user can click the “OK” button to add the information to the data grid on the “Sources” tab or click “Cancel” to abort the operation. A single source could be applicable to multiple benchmarks.
The user can add pertinent notes about a health benchmark value from the “Notes” tab. This tab is shown in Figure C27. The user can add a note by clicking the “Add” button. This will bring up a dialog box like that shown in Figure C28.
The user should provide a short description as well as a full description of the note. The short description should be entered into the “Note Short Description” field and the full description should be entered into the “Note Full Description” field. After supplying the required information, the user can click the “OK” button to add the information to the data grid on the “Notes” tab or click “Cancel” to abort the operation. Note that a single note could be applicable to multiple benchmarks.
The user adds benchmarks on the “Benchmarks” tab. This tab is shown in Figure C29. Note that the user should have already entered the constituent on the “Constituents” tab prior to attempting to enter a benchmark. The user can add a benchmark by clicking the “Add” button. This will bring up a dialog box like that shown in Figure C30.

![Figure C29. The Benchmark Database Editor’s Benchmarks tab.](image)

![Figure C30. The Benchmark Database Editor’s Add Benchmark dialog box.](image)
To begin entering a benchmark, the user should click the “Select” button beside the CASRN field. This will bring up a form with a listing of all of the constituents that the user has entered (i.e., on the “Constituents” tab). An example of this form is shown in Figure C31.

![Figure C31. The Benchmark Database Editor’s Select Constituent form for a benchmark.](image)

The user should click the appropriate checkbox beside the constituent for which a benchmark is to be provided. One cannot select more than one constituent in the list at a time. Once a constituent has been selected, the “OK” button should be clicked to have the constituent’s CASRN added to the CASRN field on the benchmark dialog box.

The next step is to select the media (i.e., fresh surface water, marine surface water, soil, fresh sediment, marine sediment, or groundwater) to which the benchmark will apply. TREECS™ does not currently support the use of soil benchmarks in an analysis, but is limited to the remaining media. Soil is listed because it is anticipated that it will need to be incorporated into analyses in the future; therefore, it serves as a placeholder. A media is selected by clicking the “Select” button beside the “Media” field. This will bring up a form like that shown in Figure C32.

![Figure C32. The Benchmark Database Editor’s Select Media form for a benchmark.](image)

The user should click the checkbox beside the desired media. Only one media can be selected. Once the media has been selected, the “OK” button should be clicked to have the media added to the “Media” field on the benchmark dialog box.
The next step is to select the benchmark unit (i.e., µg/L for surface or groundwater or mg/kg for sediment). Note that surface water concentrations are dissolved for ecological receptors and total (dissolved and particulate) for human receptors. A unit is selected by clicking the “Select unit” button. This will bring up a form like that shown in Figure C33.
The user should click the checkbox beside the desired unit. Only one unit can be selected. Although it is listed, “%” is not an acceptable unit for a benchmark. It is limited to the total organic carbon (TOC) unit, which is not selectable by the user. If this unit is selected, then a message indicating so will be received by the user when he/she clicks the “OK” button. It should be noted that the editor will check that the unit selected is appropriate for the media selected. Once the unit has been selected, the “OK” button should be clicked to have the unit added immediately behind the “Benchmark Value” field on the benchmark dialog box.

The user must then decide whether to enter a specific benchmark value or allow TREECS™ to calculate a benchmark value based on a range of applicable benchmarks that are associated with TOC range. The range option for benchmarks is currently limited in TREECS™ to either fresh or marine sediment. However, the editor will allow the user to specify a range of benchmark values for other media. It should be noted that this range will not be used in TREECS™. If the user intends to provide a single benchmark value, then he/she can enter the value into the “Benchmark Value” field. If not, then the “Benchmark Value” field should be left blank.

Once the benchmark has been decided upon, the receptor should be selected to which the benchmark will apply. A receptor is selected by clicking the “Select” button beside the “Receptor” field. This will bring up a form like that shown in Figure C34. The user should click the checkbox beside the desired receptor. Only one receptor can be selected. Once the receptor has been selected, click the “OK” button to have the receptor added to the “Receptor” field on the benchmark dialog box.

If the user’s media is fresh or marine sediment and he/she has decided that he/she wishes to supply a range of benchmark values that are tied to the sediment TOC, then he/she can click the “Benchmark falls within a range of values” checkbox. This will disable the “Benchmark value” field and enable the “Range low value,” “Range high value,” “TOC low value,” and “TOC high value” fields. Of these inputs, only the “Range low value” is used by TREECS™. However, you must still provide values for the “Range high value,” “TOC low value,” and “TOC high value” fields. The “Range high value” entered should be 100 times that of the “Range low value” field. The “TOC low value” entered should be 1.0 and the “TOC high end” value entered should be 100.0. The equation used in TREECS™ to calculate the benchmark for sediment from the range of values is:
Figure C34. The Benchmark Database Editor’s Select Receptor form for a benchmark.

\[
\text{Benchmark} = (\text{LowRangeValue}) \times (\text{SedimentTOC}) \times 100.0 \quad (C1)
\]

where SedimentTOC is an input (i.e., the Sediment TOC value) on the DoD Target Health Benchmarks tab of TREECS™ and expressed as a fraction.

If applicable, the next step is to associate the benchmark information with its source or sources. A source must have already been entered on the “Sources” tab before it can be associated with a benchmark. This is done by clicking the “Select” button beside the Source #1 field. If there is more than one source, then it can be specified using the “Select” button beside the Source #2 field. For either of these, a form like that shown in Figure C35 will be displayed.

The user should click the checkbox beside the desired source. Only one source can be selected at a time. Once the source(s) has/have been selected, the “OK” button should be clicked so the source’s short name will be added to the appropriate Source #1 or Source #2 fields on the benchmark dialog box.

If applicable, the next step is to associate the benchmark information with any applicable notes. A note must have already been entered on the “Notes” tab before it can be associated with a benchmark. This is done by selecting the “Select” button beside the Note #1 field. If there is more than one note, then it can be specified using the Select button beside the Note #2, Note #3, Note #4, and Note #5 fields as necessary. For either of these, a form like that shown in Figure C36 will be displayed.
The user should click the checkbox beside the desired note. Only one note can be selected at a time. Once you have selected the note, click the OK button to have the note’s short description added to the appropriate Note #1, Note #2, Note #3, Note #4 or Note #5 fields on the benchmark dialog box.
Munitions Database Editor

The user can create or modify a user-defined munitions database by selecting the “Munitions Database Editor” option from the “Tools” menu of TREECS™. When the user selects this option, a form like that shown in Figure C37 is displayed.

![Figure C37. The Munitions Database Editor main form.](image)

The main form has four main menus: “File,” “Add,” “Edit,” and “Help.” Using the “File” menu (Figure C38), the user can create a new munitions database (using “New”); open an existing munitions database (using “Open”); save the current database (using “Save”); save the current database under a new name (using “Save As”); or exit (using “Exit”).

The “Add” menu item (Figure C39) allows the user to add a new munition to the database (using “Munition”) and add MC to a munition (using “Munition Constituents to Munition”). This menu is initially disabled until the user either creates a new database or opens an existing database. A munition must have already been added before MC can be added to the munition.

The “Edit” menu item (Figure C40) allows the user to edit an existing munition (using “Munition”) and allows the user to edit existing MC in a munition (using “Munition Constituents within a Munition”). This menu is initially disabled until the user either creates a new database and adds a munition or opens an existing database.
The "Help" menu item (Figure C41) allows the user to get help on using the editor (using "Help") and displays information about the editor itself (using "About").
To create a new user-defined munitions database, the user can either begin with a blank database or start from an existing munitions database. The user could make a copy of the munitions database installed with TREECS™ and use it. The latter is located in the “C:\Prog Files\TREECS\Databases\” directory as “Munitions.xml.” The “Munition Items Disposition Action System (MIDAS)” is a good source for munition information (https://midas.dac.army.mil/).

To begin with a blank database, the “New” menu item should be used; next, a filename should be provided for the database in the “Open File” dialog box that is immediately displayed after selecting this menu item. After supplying the filename for the new database, a message will be displayed like that shown in Figure C42. The user can then begin creating his/her own user-defined munitions database that can be used in TREECS™.

The first thing that the user needs to do is to enter munitions. This is done by clicking the Add menu’s “Munition” menu item. This will bring up a dialog box like that shown in Figure C43.
The user is required to enter the name of the munition (e.g., 155mm Howitzer) as well as the National Stock Number (NSN) and the Department of Defense Identification Code (DODIC) for the munition. The NSN is typically a 13-digit number that uniquely identifies a given munition among other standard material supply items. An example of this number is 1320009269319. No duplicates are allowed for a NSN. The DODIC is a four-digit alphanumeric character that identifies ammunition and explosive items within the supply system of the armed forces. An example of this identifier is D544. The user should click the “Add” button to add the munition. After adding a munition, it will then show up in the Existing munitions listbox. This procedure should be repeated for each munition that is desired in the database. Clicking the “OK” button commits the transaction; clicking “Cancel” aborts the operation.

After a munition has been added to the database, the MC contained within the munition can be specified. This is done with the Add menu’s “Munition Constituents to Munition” menu item. After selecting this menu item, a dialog box like that shown in Figure C44 will be displayed.

The user should select the munition to which MC is to be added in the “Munition to Which to Add the MC” combobox. Next, the user must enter or select the MC. This is done by entering the name of the constituent in the
“Name” field and the CASRN (without hyphens) in the “CASRN” field or by clicking the “Select” button and selecting the desired constituent from the listbox and clicking “OK” on the form that is displayed. The latter will then populate the corresponding constituent name and CASRN fields for the user based on his/her selection. This lookup functionality is achieved by a database that contains the constituent names and CASRNs of every constituent found in the FRAMES, RAIS, and Range constituent databases. An example of this form is shown in Figure C45. The form also allows the user to search for a particular MC.

After entering or selecting the MC name and CASRN, the user should then provide the mass, in grams, of the particular MC within the munition. MC can exist in various locations within a given munition; it can be located at the impact point, firing point, firing point recovery, or at other locations. The user must specify this location using the appropriate option in the “Location” combobox. In addition, MC can exist in different basic material types. The material types recognized are propellant, explosive, or pyrotechnic (PEP), bulk, and inert. This is done by making the appropriate selection from the “Material Type” combobox. The user must also specify whether the MC is present in a standard (STD) or in an alternate (ALT) form of the munition. This is done by making the appropriate selection in the “Standard/Alternate” combobox. TREECS™ only processes standard munitions; it does not process alternate forms of a munition.
Figure C45. The Munitions Database Editor's Select Munition Constituents form.

After entering the required information, the “Add” button will become enabled. This button should be clicked to add the MC to the database and the process repeated for each additional MC to be added to a munition. If the user would like to see all existing MC already specified at a particular location, or that is a certain material, and/or that is a standard/alternate form of the munition, the user can make the desired selection in the “View Munition MC” area of the dialog box and it will display all MC for the selected view options in the corresponding data grid. Once he/she has completed adding MC to a munition, the “OK” button must be clicked to commit the transaction or “Cancel” may be clicked to abort the operation.

If the user needs to edit or delete a munition that has already been entered, then that can be done with the Edit menu’s Munition menu item. If this menu item is selected, a dialog box like that shown in Figure C46 will be displayed.

The user can select the desired munition to be edited or deleted in the listbox and then click the “Edit” or “Delete” buttons. If he/she clicks “Delete,” the editor will prompt for confirmation prior to deleting the munition. If he/she clicks “Edit,” then a dialog box like that shown in Figure C47 will be displayed. The user should select the desired munition to edit from those listed in the “Select Munition” combobox. This will populate the basic property fields of the munition (i.e., name, NSN, and DODIC). The user can then edit any of these fields. The user should click the “Update” button to
register his/her changes for the selected munition. The user can then repeat this process for all munitions that need to be edited. Once complete, click the “OK” button to commit the transaction. Click “Cancel” to abort the operation.

![Edit or Delete Munition form](image)

**Figure C46.** The Munitions Database Editor’s Edit or Delete Munition form.

![Edit Basic Munition Description form](image)

**Figure C47.** The Munitions Database Editor’s “edit munition” form.

If the user needs to edit or delete an MC within a munition for which he/she has already entered, then that can be done with the Edit menu’s “Munition Constituents within a Munition” menu item. If the user selects this menu item, a dialog box like that shown in Figure C48 will be displayed.
The user can select the munition for which its MC is to be edited or deleted in the “Select munition to edit the MC of” combobox. The user must then select the location, material type, and standard or alternate form of the munition by making the appropriate selections in the Location, Material, and Standard or Alternate comboboxes. This will populate the “MC components of selected munition” data grid with the information for the MC within the munition and the given constraints. The user can delete an MC by first selecting the row to be deleted in the data grid and then clicking the “Delete row” button. To delete all the MC within a munition, the “Delete all rows” button should be clicked. To change the mass for a given MC, the Mass, g cell in the data grid must be edited and then the "Save changes to mass" button must be clicked to save the MC mass edit. Other locations, material types, or standard/alternate forms can then be selected and this process repeated. This process can be repeated for other munitions. If the user clicks the “OK” button, his/her modifications will be committed. Click “Cancel” to abort the operation.

Once the user has made all additions or edits to the database, he/she can save any changes with the File menu’s “Save” option. Changes may also be saved with a new name by using the “Save As” menu item, which will prompt the user for the file path and name under which to save that database.
### 14. ABSTRACT
This report was developed to provide a user guide and tutorial for applying the Training Range Environmental Evaluation and Characterization System (TREECS™). The purpose of TREECS™ is to provide the Army with varying levels of capability to forecast the fate of and environmental risk from munitions constituents (MC), such as high explosives (HE), present in and transported from firing/training ranges to surface water and groundwater. The overall objective is to provide Army environmental specialists with tools to assess the potential for migration of MC into surface water and groundwater systems and to assess range management strategies to protect human and environmental health. Tier 1 consists of screening-level methods that assume highly conservative, steady-state MS loading and fate. Tier 2 provides time-varying analyses. This report provides information to assist the user in learning how to apply TREECS™ for Tier 1 and 2.

### 15. SUBJECT TERMS
- Human and environmental health
- Fate of munitions constituents (MC)
- Range management strategies
- Fort A.P. Hill
- Training Range Environmental Evaluation and Characterization System (TREECS™)

### 16. SECURITY CLASSIFICATION OF:
- a. REPORT: UNCLASSIFIED
- b. ABSTRACT: UNCLASSIFIED
- c. THIS PAGE: UNCLASSIFIED

### 17. LIMITATION OF ABSTRACT
- 19b. NAME OF RESPONSIBLE PERSON

### 18. NUMBER OF PAGES
- 207

### 19b. TELEPHONE NUMBER (include area code)

---

**Standard Form 298 (Rev. 8-98)**
Prepared by ANSI Std. 239.18